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Chapter 1. About Using SPEC2000 with IBM Sterling B2B
Integrator

SPEC2000 is a comprehensive set of e-business specifications, products, and
services that are designed to overcome challenges in the aviation industry supply
chain. Administered by the Air Transport Association (ATA), SPEC2000 is the
product of 12 international industry associations representing airlines,
manufacturers, suppliers, and repair agencies. The primary goal is to provide
cost-effective, state-of-the-art methods for information exchange that are usable by
the widest possible population of companies. Today the system includes four types
of information exchange that comprise the SPEC2000 e-business system:
v ATA Aviation Marketplace
v E-Commerce Standards
v File Standards
v Bar Coding Standards

When used in a batch file, the SPEC2000 format consists of a sequence of records,
in which each record may contain a series of segments. Each segment (or record, if
it is not determined in terms of segments) consists of a set of control data elements
which are slash-delimited, and usually begin with a Text Element Identifier (TEI).
If the control data element does not begin with a TEI, the meaning of this control
data element is implicit based on its order within the containing record or
segment. There is typically one piece of data within a control data element, but
sometimes it contains multiple pieces of data. Some data control elements are
required to be present in a particular order, while others may appear in any order.
Each data field is separated by a slash. Some records (for example, the header
record of the V File) are required to have a slash delimiter at the end of the record,
while other records (for example, the provisioning data record of the V file) are
required to end with a space rather than a slash.

Note: Sterling B2B Integrator does not support theIBM Sterling B2B Integrator
Map Editor preloads for the messages specified for Automated Identification and
Data Capture (Chapter 9 of the SPEC2000 documentation).

This table describes how Sterling B2B Integrator supports SPEC2000:
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Functionality Details
Action You Need to Take to
Implement SPEC2000

Services v Generic Enveloping service
translates messages, determines
which business processes need to
run to apply SPEC2000 envelopes,
and starts those business processes.
This service improves performance
of SPEC2000 by consolidating the
inner and outer envelopes into a
single service.

v Generic Deenveloping service
removes the envelopes from
inbound messages.

Configure the Generic
Enveloping and
Deenveloping services in
Sterling B2B Integrator
Graphic Process Modeler
(GPM).
Note: As a way to help
reduce the number of
envelopes you need to create
and use, the services support
use of an asterisk (*) as a
wildcard character in
mandatory envelope fields for
SPEC2000. By using
wildcards, you can set up one
set of envelopes that can be
used for multiple trading
partners. If certain trading
partners have specific
requirements, you can still
have envelopes that pertain
just to them, and the service
chooses the envelope that is
the best match. In other
words, the envelope that has
the most matches to specific
fields in the data, is the one
selected.

Envelopes v Inbound SPEC2000 envelope
wizard to implement inbound
SPEC2000.

v Outbound SPEC2000 envelope
wizard to implement outbound
SPEC2000.

Note: Most message types support
an acknowledgement in the form of
S1CMDACK. Sterling B2B Integrator
does not support the reconciliation of
business responses.

v Create the appropriate
SPEC2000 envelopes for the
SPEC2000 messages you
are sending and receiving.

Predefined business
processes

v SPEC2000Deenvelope business
process extracts documents from a
SPEC2000 envelope according to
the content of the documents.
SPEC2000Deenvelope then starts
the appropriate business process.

v SPEC2000Envelope business
process applies a SPEC2000
envelope to one or more SPEC2000
messages and then uses the
envelope data to translate and
process them.

Configure the predefined
business processes as
necessary.
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Functionality Details
Action You Need to Take to
Implement SPEC2000

Sterling B2B
Integrator Map
Editor

v Sterling B2B Integrator Map Editor
wizard enables you to generate a
file layout for you using the
preloaded SPEC2000 message that
you select. Included in the
SPEC2000 map are the map
components that are defined by
SPEC2000.

v The Sterling B2B Integrator Map
Editor wizard also enables you to
generate file layouts for positional
and XML formats.

v Properties dialog boxes that enable
you to define and modify map
components for SPEC2000,
positional, and XML file formats.

v Autolink function automatically
creates links between input and
output fields that have the same
name or business name. This
function can be used with any data
format.

v Additional mapping operations as
needed. See the Sterling B2B
Integrator Map Editor Guide for
information on other mapping
operations.

v Download Map Editor.

v Create a map or maps to
translate your SPEC2000
messages.

Correlation Search Search by SPEC2000 information. Use the EDI Correlation
search functionality to search
for SPEC2000 correlation
information.

Reports Report by SPEC2000 standard v Use the EDI Translation
Detail report to search for
details of inbound and
outbound SPEC2000
messages and easily create
useful reports on your
inbound and outbound
SPEC2000 messaging.

v Use the EDI Outbound
Acknowledgement report
to monitor functional
acknowledgments at the
transaction level, organized
by parameters including
sender identifier, receiver
identifier, EDI standard,
and acknowledgment
status. You may want to
use this report to
determine, for example,
how many functional
acknowledgments from a
specified sender identifier
are overdue.
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The audience using this software should be familiar with Sterling B2B Integrator
and the SPEC2000 standard.

Note: This documentation is not intended to explain the SPEC2000 standard.

Using SPEC2000 with Sterling B2B Integrator
About this task

To use SPEC2000 with Sterling B2B Integrator, you must complete the following
tasks:

Procedure
1. Create inbound and outbound SPEC2000 envelopes.
2. Use the predefined SPEC2000 business processes or create your own business

processes.
3. Create any necessary code lists and maintain them as needed.
4. Create your SPEC2000 map or maps, linking your proprietary file format to the

appropriate SPEC2000, positional, or XML message format.
5. To track SPEC2000 messages, use the EDI Correlation Search functionality.
6. To report on inbound and outbound SPEC2000 message flow, use the EDI

Translation Detail report features.
7. To monitor the EDI Outbound Acknowledgement report functional

acknowledgments at the transaction level, organized by parameters including
sender identifier, receiver identifier, EDI standard, and acknowledgment status.
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Chapter 2. SPEC2000 Business Processes

To help you accomplish your business goals, Sterling B2B Integrator provides two
predefined enveloping business processes that are used by Sterling B2B Integrator
to implement SPEC2000 processing: SPEC2000Envelope and SPEC2000Deenvelope.
These predefined business processes are initiated by services during SPEC2000
processing and do not require you to modify them unless modifications are
necessary to meet your business requirements.

The following table lists business goals for the predefined SPEC2000 business
processes:

Business Process
Business Goals

SPEC2000Deenvelope
Extracts documents from a SPEC2000 envelope, according to the content of
the envelopes. SPEC2000Deenvelope then starts the appropriate business
process.

SPEC2000Envelope
Applies a SPEC2000 envelope to one or more SPEC2000 messages and then
uses the envelope data to translate and process them.

SPEC2000Envelope Business Process
The SPEC2000Envelope business process is initiated when it is called by another
business process or the EDI Enveloping service.

The SPEC2000Envelope business processes performs the following primary
activities:
v Starting with one or more documents, the Generic Enveloping service applies

envelope properties at the document level to each document.
v The service either looks up a contract or runs a business process.

This table lists the configuration parameters for the SPEC2000Envelope business
process:

Parameter Default Description

Document Tracking False When document tracking is enabled for a
business process, tracking information is carried
with the message throughout the process, and
the tracking information is persisted about the
message regardless of the persistence level you
configured globally.

Transaction False Indicates whether the transaction will be sent.
False indicates that the transaction will not be
sent.
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Parameter Default Description

Set onfault
processing

False Onfault processing allows the process to
immediately execute the on-fault activity
specified in the process, even if the process has
not yet reached that step in the process.

For example, if a process fails at step 3, but the
on-fault activity is specified in step 7, if onfault
processing is enabled, the process proceeds to
the step 7 on-fault rather than halting at step 3.

Queue 4 Enables you to set performance optimizations
by queue, defining queue levels to allocate
resources. This number indicates that previously
allocated queue level that you want for this
business process model for processing.

Persistence Level System Default The level of data to retain for generating a
status report that describes each step that the
business process completes. System default
indicates that, for the data, configuration is
already defined to retain data.

Recovery Level Manual The level of recovery for this business process if
the business process should halt during
execution. Manual requires you to resume or
restart the business process manually.

Document Storage
Type

System Default The level of document storage for messages that
process when the business process runs. System
Default specifies to store messages in the file
system or database, according to how you
configured archiving and purging.

Life Span Life Span Days —
2

Life Span Hours —
0

Life Span Type —
System Level

Removal Method
— Archive

The length of time, in days and hours, to retain
the data, along with the life span type and
removal method.

Complete by
Deadline

None Available
Note: To set a
deadline you must
change it in the
business process.

Complete by – The deadline time, in hours and
minutes, by which the business process must
complete process once it starts.

v First Notification: Hours and Minutes –
Whether to receive notification before a
business process deadline.

v Second Notification: Hours and Minutes –
Whether to receive another notification before
a business process deadline.

Event Reporting
Level

Full The level of event reporting that is retrieved for
this business process when it runs. Full specifies
to generate events for the business process,
including the business process start and end
time, start and end times for all services or
services running as a result of this business
processes, and any resulting errors and
exceptions.
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Parameter Default Description

Removal Method System Default The method of removing files for this business
process. The system default is “Archived.”

Start Mode Async The business process can be configured to
execute in synchronous mode and asynchronous
mode.

The following BPML code makes up the SPEC2000Envelope business process:
<process name="SPEC2000Envelope">

<rule name="contract">
<condition>CONTRACT_FOUND = "YES"</condition>

</rule>

<sequence>
<sequence>

<operation>
<participant name="EnvelopeGeneric" />
<output message="Xout" >

<assign to="." from="*"></assign>
</output>
<input message="Xin" >

<assign to="." from="*"></assign>
</input>

</operation>
<onFault code="Translation-Error-Some-Docs">

<assign to="BREAK">YES</assign>
</onFault>
<onFault code="Envelope-Translation-Error-Some-Docs">

<assign to="BREAK">YES</assign>
</onFault>
<onFault>

<operation>
<participant name="BPExceptionService"/>
<output message="Xout" >

<assign to="exceptionCode" from="Prev_NotSuccess_Adv_Status/text()"/>
</output>
<input message="Xin"/>

</operation>
</onFault>

</sequence>

<choice>
<select>

<case ref="contract" activity="invoke_contract_workflow" />
</select>
<sequence name="invoke_contract_workflow">

<operation>
<participant name="InvokeBusinessProcessService" />
<output message="Xout">

<assign to="INVOKE_MODE">ASYNC</assign>
<assign to="." from="*"></assign>

</output>
<input message="Xin" >

<assign to="." from="*"></assign>
</input>

</operation>
</sequence>

</choice>

</sequence>
</process>
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Before Using the SPEC2000Envelope Business Process
Before you use the SPEC2000Envelope business process, you must complete the
following tasks:
1. Create inner and outer outbound envelopes for your SPEC2000 messages.
2. Create a business process that initiates the SPEC2000Envelope business process.

SPEC2000Deenvelope Business Process
The SPEC2000Deenvelope business process includes the Generic Deenveloping
service to perform the following tasks:
v Extracts documents into process data.
v Starts the SPEC2000 Deenveloping business process or other EDI Deenveloping

business process, as appropriate.

If exceptions occur when running a SPEC2000Deenvelope business process,
Sterling B2B Integrator generates an EDI Compliance Report.

This table lists the configuration parameters for the SPEC2000Deenvelope business
process:

Parameter Default Description

Document Tracking False When document tracking is enabled for a
business process, tracking information is carried
with the message throughout the process, and
the tracking information is persisted about the
message regardless of the persistence level you
configured globally.

Transaction False Indicates whether the transaction will be sent.
False indicates that the transaction will not be
sent.

Set onfault
processing

False Onfault processing allows the process to
immediately execute the fault activity specified
in the process, even if the process has not yet
reached that step in the process.

For example, if a process fails at step 3, but the
on-fault activity is specified in step 7, if onfault
processing is enabled, the process proceeds to
the step 7 on-fault rather than halting at step 3.

Queue 4 Enables you to set performance optimizations
by queue, defining queue levels to allocate
resources. This number indicates the previously
allocated queue level that you want for this
business process model for processing.

Persistence Level System Default The level of data to retain for generating a
status report that describes each step that the
business process completes. System default
indicates that, for the data, configuration is
already defined to retain data.

Recovery Level Manual The level of recovery for this business process if
the business process should halt during
execution. Manual requires you to resume or
restart the business process manually.
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Parameter Default Description

Document Store System Default The level of document storage for messages that
process when the business process runs. System
Default specifies to store messages in the file
system or database, according to how you
configured archiving and purging.

Life Span Life Span Days —
2

Life Span Hours —
0

Life Span Type —
System Level

Removal Method
— Archive

The length of time, in days and hours, to retain
the data, along with the life span type and
removal method.

Complete by
Deadline

None Available
Note: To set a
deadline you must
change it in the
business process.

Complete by – The deadline time, in hours and
minutes, by which the business process must
complete process once it starts.

v First Notification: Hours and Minutes –
Whether to receive notification before a
business process deadline.

v Second Notification: Hours and Minutes –
Whether to receive another notification before
a business process deadline.

Event Reporting
Level

None The level of event reporting that is retrieved for
this business process when it runs. Full specifies
to generate events for the business process,
including the business process start and end
time, start and end times for all services or
services running as a result of this business
process, and any resulting errors and exceptions.

Removal Method System Default The method of removing files for this business
process. The system default is “Archived.”

Start Mode Async The business process can be configured to
execute in synchronous mode and asynchronous
mode.

The following BPML code makes up the SPEC2000Deenveloping business
process:
<process name="SPEC2000Deenvelope">

<rule name="contract">
<condition>CONTRACT_FOUND = "YES"</condition>

</rule>
<sequence>

<sequence>
<operation>

<participant name="DeenvelopeGeneric"/>
<output message="toService" >

<assign to="break_processor">SPEC2000</assign>
<assign to="ExhaustInputDuringBreakTranslation">false</assign>
<assign to="." from="*"/>

</output>
<input message="fromService" >

<assign to="." from="*"/>
</input>

</operation>
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<onFault code="Interchange-Non-Compliant">
<assign to="BREAK">YES</assign>

</onFault>
<onFault code="Transaction-Non-Compliant">

<assign to="BREAK">YES</assign>
</onFault>
<onFault>

<operation>
<participant name="BPExceptionService"/>

<output message="toService">
<assign to="exceptionCode" from="Prev_NotSuccess_Adv_Status/text()"/>

</output>
<input message="fromService"/>

</operation>
</onFault>

</sequence>
<choice>

<select>
<case ref="contract" activity="invoke_contract_workflow"/>

</select>
<sequence name="invoke_contract_workflow">

<operation>
<participant name="InvokeBusinessProcessService"/>
<output message="toService">

<assign to="INVOKE_MODE">ASYNC</assign>
<assign to="." from="*"/>

</output>
<input message="fromService" >

<assign to="." from="*"/>
</input>

</operation>
</sequence>

</choice>
</sequence>

</process>

Before Using SPEC2000Deenvelope
Before you use the SPEC2000Deenvelope business process, you must complete the
following tasks:
1. Create SPEC2000 inbound envelopes.
2. Create a business process that initiates the SPEC2000Deenvelope business

processes.
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Chapter 3. SPEC2000 Enveloping

A document envelope consists of control information that enables organizations to
effectively exchange messages. This information is added in headers and trailers to
messages. Document envelopes are specific to the message protocol used. Creating
document envelopes is necessary to use SPEC2000 with your trading partners.

During the envelope creation process, you need to assign the envelope name,
description, and parameters, such as unique identification numbers (control
numbers).

Note: Each time a user adds, modifies, or deletes an envelope, the action is logged
to create an audit trail based on the user who performed the event.

Each envelope type has a specific properties page for the envelope and other pages
that enable you to specify additional requirements for the envelope. Properties for
the following envelopes can be found in this documentation:
v Outbound SPEC2000 ATA_InformationSet Envelope
v Outbound SPEC2000 Message XML Envelope
v Inbound SPEC2000 Message XML Envelope
v Outbound SPEC2000 CMD Outer Envelope
v Outbound SPEC2000 Command Message Envelope
v Inbound SPEC2000 Command Message Envelope

Document Lifespan
In previous releases, the document lifespan default was zero so that when the
workflow expired, all associated documents were purged/archived with the
workflow. Now the lifespan for ASC X12 documents awaiting acknowledgement is
configurable, and the default is 30 days.

Note: You can change the default lifespan by editing the document.lifespan
property in the enveloping.properties file. The document lifespan of the outbound
document is automatically reset to zero after the acknowledgement for the
document is received or if the user manually accepts the acknowledgement.

Envelope Structure
Sterling B2B Integrator supports the use of many different standard protocols,
including SPEC2000. The SPEC2000 protocol has one level of envelope, except for
outbound command messages, which have two levels of envelopes (an outer
envelope and a command message envelope).

Base Envelopes
Sterling B2B Integrator uses a concept of a base envelope as a starting point to create
a new envelope. The base envelope maintains a link to the new envelope that
inherited its properties. If you modify the base envelope, all related envelopes (that
is, ones that inherited the base envelope properties) change, as well.
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Note: If you plan to create many envelopes using base envelopes, it is
recommended that you do not use the base envelopes in production. You may
want to document how your base envelopes are linked to other envelopes.

The default envelope is the version of the document envelope that Sterling B2B
Integrator uses. You can specify a default envelope only if there are two or more
versions of the same envelope. One version must be selected as the default.

Types of Envelopes
There are many types of envelopes provided in Sterling B2B Integrator. Each
envelope is defined by its envelope properties. These predefined enveloping and
deenveloping business processes are available for you to incorporate into your own
business processes. Envelope parameters specify whether the document is inbound
or outbound:
v Inbound envelopes identify documents that come into Sterling B2B Integrator so

they can be properly routed. Inbound envelopes also give you the option to
translate documents when you choose to check documents for compliance. By
choosing to translate documents from within the envelope, you can reduce
document processing time because you do not need to specify a separate
Translation service step in the business process.

v Outbound envelopes identify documents so that they can be sent to and received
by trading partners.

Using Wildcards
As a way to help reduce the number of envelopes you need to create and use, the
EDI Enveloping and EDI Deenveloping services support use of an asterisk (*) as a
wildcard character in mandatory envelope fields for the SPEC2000 standard. If
optional fields are not provided in the envelope, they should not match data that
provided values for those optional fields unless they were wildcarded in the
envelope. If optional fields are not provided in the data, they should not match
envelopes which defined values for those fields unless they were wildcarded in the
envelope. If certain trading partners have specific requirements, you can create
envelopes that pertain just to them, and the EDI Enveloping service chooses the
envelope that is the best match. That is, the envelope that has the most matches to
specific fields in the data (for example, Receiver ID and Receiver ID Qualifier), is
the one selected.

Wildcards in Deenveloping (Inbound)
The EDI Deenveloping service receives data, parses the headers, and extracts the
EDI information from it. The service searches the available envelopes for the
closest match to the EDI data.

When setting up enveloping with wildcards, consider the following:
v The Deenveloping service selects the envelope that matches the EDI data most

closely. For example, if an envelope has the same Transaction ID as the incoming
data, and another envelope has wildcards in all mandatory fields, the envelope
with the matching Transaction ID is used.

v Sender ID and Receiver ID have priority over other EDI fields. For example, two
envelopes are found that have a field that matches one EDI field from the data.
One envelope matches the value in the Receiver ID field from the data; the other
matches the Transaction ID field. The envelope that has the matching Receiver
ID is selected by the service and used for processing.
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v If no envelopes are found that have an exact match to fields in the EDI data, and
an envelope with wildcards does exist, the envelope with wildcards is used.

v If multiple envelopes have the same matching information (for example, two
envelopes match the Sender ID and Receiver ID exactly) the service ends with
an error.

v The wildcard character is an “all or nothing” parameter. That is, if using
asterisk, you cannot enter other characters in the field with it. For example, you
can not enter Me* to match MeaslesAnimalHaven and Medeira Foods.

Wildcards in Enveloping (Outbound)
For Inbound envelopes, a wildcard value in the envelope matches any value in the
input document, while an empty value in the envelope matches only an empty
value in the input document. For Outbound envelopes, a wildcard value is
equivalent to an empty value in the envelope. You can override wildcards with
specific EDI values in outbound processing. You must supply the EDI data to the
business process and the data must be in the correct format (that is, name/value
pairs).

One option is to use the lightweight JDBC adapter to pull fields in from database
tables. Whatever method you choose to retrieve the fields, the results must be
given to the Correlation service, which places them into process data. Passing the
data to the Correlation service must be the last step in the business process before
running the EDI Encoder service. When the EDI Encoding service runs, it uses the
same best-match process detailed in the Inbound section to determine which
envelope to use. When the SPEC2000 envelope service runs, any envelope field
values set in the Correlation service overrides those values defined in the envelope
definition.

When setting up your outbound processing, consider the following:
v If an envelope field contains a wildcard, you must supply a correlation value for

it or the service halts with an error.
v You can override wildcard values in an envelope by using the Correlation

service to pass name/value pairs from the primary document to the EDI
Encoder service.

v If an envelope contains specific values in the Sender ID, Sender ID Qualifier,
Receiver ID, or Receiver ID Qualifier fields (that is, values other than a
wildcard), the values passed from the Correlation service to the EDI Encoder
service do not overwrite the values in the fields.

v If you are using the same envelope for inbound processing and
acknowledgements, supply the Sender ID, Receiver ID, and Qualifiers in the
envelope so that they are not overwritten by the correlation values.

Creating a SPEC2000 Envelope
About this task

To create a new envelope using Sterling B2B Integrator:

Procedure
1. From the Administration menu, select Trading Partner > Document Envelopes

> Envelopes.
2. Under Create, next to New Envelope, click Go!

3. On the Envelope Standards page, select SPEC2000 and click Next
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4. Select the type of envelope you want to create, including inbound or outbound,
and click Next.

5. Do one of the following:
v To create this envelope from a base envelope, select the Base envelope from

the Select Envelope list, and click Next.

Note: All the properties are pre-filled but you can update them as needed.
v To create a new envelope, select the Not Applicable from the Select Envelope

list, and click Next.
6. On the Name page, type a unique name for the envelope, and a description or

comments, then click Next.
7. Complete the properties for the envelope as necessary and click Next after each

page until you reach the confirm page. Required fields are highlighted in blue.
8. Click Finish to add the envelope.
9. Click Return to continue.

Updating a SPEC2000 Envelope
About this task

Sterling B2B Integrator enables you to modify any information in your envelopes,
except the name of the envelope.

To update envelope properties:

Procedure
1. From the Administration menu, select Trading Partner > Document Envelopes

> Envelopes.
2. Find the envelope using the Search or List function.
3. From the list of envelopes, click source manager next to the envelope you want

to update.
4. Click edit next to the envelope you want to update.
5. Update envelope properties and settings as necessary, clicking Next to continue.
6. Click Finish to update the envelope.
7. Click Return to continue.

Deleting a SPEC2000 Envelope
About this task

Note: Before deleting a base envelope, consider the impact on all related envelopes
(envelopes that inherited the base envelope properties).

To delete an individual envelope or all versions of an envelope:

Procedure
1. From the Administration menu, select Trading Partner > Document Envelopes

> Envelopes.
2. Find the envelope using the Search or List function.
3. Next to the envelope you want to delete, click source manager.
4. To delete an individual envelope, in the Envelope Source Manager page:
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a. Next to the version, under Delete, select the check box.
b. Next to Delete Selected Versions, click Go!

5. To delete all versions of this envelope, in the Envelope Source Manager page,
next to Delete All Versions, click Go!

Importing and Exporting Envelopes
The Import/Export feature enables you to save time and increase the accuracy of
duplicating resources on different systems. This feature enables you to move
resources and data between application environments of the same version. The
Import/Export feature enables you to:
v Move from a test application environment to a production application

environment.
v Move resources from one application system to another.

The ability to import and export envelopes means that you can configure resources
on one system and then move or copy them to a different system, thereby avoiding
having to recreate the resources on each system. Even If you have resources that
are going to be slightly different from one system to another, you can export the
resources from one system and import them to a different system, and then make
the necessary changes to the resource on the second system.

The Import/Export feature supports several different resource types, including
envelopes.

Note: Importing an export file of envelopes always requires a passphrase, even if a
passphrase was not required during the export. The passphrase is now required
because of the addition of encrypted passwords that apply to some envelopes.
When you are prompted for a passphrase for envelopes during the import of
envelopes (when you did not use a passphrase when the envelopes were
exported), you can supply any value for the passphrase.

Inbound SPEC2000 Command Message Envelope

Note: An (*) asterisk indicates that a wildcard value can be used with that
parameter (for mandatory fields, the wildcard value is an (*) asterisk). For Inbound
envelopes, a wildcard value in the envelope matches any value in the input
document, while an empty value in the envelope matches only an empty value in
the input document. For Outbound envelopes the wildcard value will be matched
with the values present in your custom business process, depending on the
Correlation Override Value set in the envelope.

The following table describes the Inbound SPEC2000 Command Message envelope
properties:

Field Description

* Originator Address[Sender ID]
The message sender as it should appear on the interchange header
segment sent to this company or division. The valid value is seven to eight
characters. Required.

* Destination Address[Receiver ID]
The message receiver as it should appear on the interchange header
segment sent to this company or division. The valid value is seven to eight
characters. Required.
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* Message Type
The type of message. Select a message type from the list or choose
wildcard (*) to allow any message. Default is * (wildcard). Required.

Generate an S1CMDACK Acknowledgement Message
Whether to generate an acknowledgement that notifies the sender that the
receiver has received either a non-compliant document or an interpretable
document transmission. Required. Valid values are Yes (default) and No.

Acceptor Lookup Alias for S1CMDACK Acknowledgement
Alias for accepter lookup for generated acknowledgements. Required if
you selected S1CMDACK.

Send acknowledgement immediately
Whether to send the generated S1CMDACK immediately. Valid values are :
Yes and No (default). Required.

Handling of non-compliant Messages
How non-compliant messages are handled. Valid values are Accept
compliant and non-compliant transactions and Accept compliant
transactions, reject non-compliant transactions (default).

Compliance Check Document
Check the document body for compliance. Valid values are Yes and No.
Required.

Map Name Mode
Mode in which to specify the map to use to perform a compliance check.
Valid values are:
v Specify
v Generate from data

Compliance Check Map Name
Which map to use to perform a compliance check. The map must already
be checked in. Select the map. Required if you selected Specify for Map
Name Mode.

Primary Name Format
Check boxes to instruct what information to include when generating and
matching a name for the map. Required.

Select from:
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated map name (Map Name Mode is set to
Generate from data), Sterling B2B Integrator tries to generate and match
the following maps:
First, it tries to generate and match the map in the primary name format
(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.
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First Backup Name Format
The first backup name format to use when generating a map name. The
system allows for two alternatives if the Primary Name Format is not
found-checking for the First Backup Name Format and then, if that is not
found, checking for the Second Backup Name Format. Optional.

Select from:
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated map name (Map Name Mode is set to
Generate from data), Sterling B2B Integrator tries to generate and match
the following maps:
First, it tries to generate and match the map in the primary name format
(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.

Second Backup Name Format
The second backup name format to use when generating a map name. The
system allows for two alternatives if the Primary Name Format is not
found-checking for the First Backup Name Format and then, if that is not
found, checking for the Second Backup Name Format. Optional.

Select from:
v Originator Address
v Destination Address
v Message Type

are using a generated map name (Map Name Mode is set to Generate from
data), Sterling B2B Integrator tries to generate and match the following
maps:
First, it tries to generate and match the map in the primary name format
(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.

Generate an error if no generated map name exists in the system
Specifies whether to generate an error if the Map Name selected is not
found. Valid values are Yes (default) and No.

Note: Only displayed if Map Name Mode is set to Generate from data.
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Keep translated document after compliance check
Whether to keep the translated document after performing the compliance
check. Valid values are Yes (default) and No. Required.

Validate translation output
Whether to validate the translation output. Valid values are Yes (default) or
No. Required.

Error business process mode
How to determine which business process name to use if there were errors
in the compliance check. Required. Valid values are:
v Specify (default)
v Generate from data

Note: If you select the Generate from data option, you must select at least
one parameter for Primary Name Format.

Business Process for Non-Compliant Documents
Business process to be used when non-compliant documents are
encountered. Optional.

Displayed only if Error Business Process Name is set to Specify.

Primary Name Format
Check boxes to instruct what information to include when generating and
matching a name for the business process. Required.

Select from:
v Originator Address
v Destination Address
v Message Type

Displayed when Generate from data is specified for Business Process for
Non-compliant Documents.

Note: If you are using a generated business process name (Error Business
Process is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

First Backup Name Format
The first backup name format to use when generating a business process
name. The system allows for two alternatives if the Primary Name Format
is not found-checking for the First Backup Name Format and then, if that
is not found, checking for the Second Backup Name Format. Optional.

Select from:
v Originator Address
v Destination Address
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v Message Type

are using a generated business process name (Error Business Process is set
to Generate from data), Sterling B2B Integrator tries to generate and match
the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Second Backup Name Format
The second backup name format to use when generating a business
process name. The system allows for two alternatives if the Primary Name
Format is not found-checking for the First Backup Name Format and then,
if that is not found, checking for the Second Backup Name Format.
Optional.

Select from:
v Originator Address
v Destination Address
v Message Type

Note: are using a generated business process name (Error Business Process
is set to Generate from data), Sterling B2B Integrator tries to generate and
match the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Generate an error if no generated business process exists in the system
Specifies whether to generate an error if the business process selected is
not found. Valid values are Yes (default) and No.

Note: Only displayed if Error business process mode is set to Generate
from data.

Determine the business process by
How to determine which business process name to use if there were no
errors in the compliance check. Required. Valid values are:
v Specifying a business process (default)
v Generating the business process name from the data

Note: If you select this option, you must select at least one parameter for
Primary Name Format.
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Primary Name Format
Check boxes to specify which information to include when generating and
matching a name for the business process. Required.

Select from:
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated business process name (Determine the
Business Process By is set to Generating the business process name from
the data), Sterling B2B Integrator tries to generate and match the following
business process:
v First, it tries to generate and match the business process in the primary

name format (replacing the values that are selected for the
corresponding value in the message).

v Second, it tries to generate and match the first Backup Name.
v Third, it tries to generate and match the second Backup Name.
v Fourth, if there is not an existing business process that matches the

names generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

First Backup Name Format
The first backup name format to use when generating a business process
name. The system allows for two alternatives if the Primary Name Format
is not found-checking for the First Backup Name Format and then the
Second Backup Name Format. Optional.

Select from:
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated business process name (Determine the
Business Process By is set to Generating the business process name from
the data), Sterling B2B Integrator tries to generate and match the following
business process:
v First, it tries to generate and match the business process in the primary

name format (replacing the values that are selected for the
corresponding value in the message).

v Second, it tries to generate and match the first Backup Name.
v Third, it tries to generate and match the second Backup Name.
v Fourth, if there is not an existing business process that matches the

names generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Second Backup Name Format
The second backup name format to use when generating a business
process name. The system allows for two alternatives if the Primary Name
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Format is not found-checking for the First Backup Name Format and then
the Second Backup Name Format. Optional.

Select from:
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated business process name (Determine the
Business Process By is set to Generating the business process name from
the data), Sterling B2B Integrator tries to generate and match the following
business process:
v First, it tries to generate and match the business process in the primary

name format (replacing the values that are selected for the
corresponding value in the message).

v Second, it tries to generate and match the first Backup Name.
v Third, it tries to generate and match the second Backup Name.
v Fourth, if there is not an existing business process that matches the

names generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Generate an error if no generated business process name exists in the system
Specify whether to generate an error if there is no match to the generated
business process name in the system. Valid values are Yes (default) and
No.

Note: Only displayed if Determine the Business Process By is set to
Generating the business process name from the data.

Business Process List
Select a previously created business process to associate with this envelope
Optional.

Displayed only if Determine the Business Process Name is set to
Specifying a business process.

Extraction Options
Business process data extraction. Required.

Valid values:
v Determined by business process (default)
v Extract to a file system directory
v Extract to a mailbox

Data Extraction Directory
Directory for data extraction. Optional.

Data Extraction Filename
Filename for data extraction. Optional.

Data Extraction Mailbox
Mailbox for data extraction. Required.

Data Extraction Mailbox Message Name
Mailbox message name for data extraction. Optional.
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Inbound SPEC2000 Message XML Envelope

Note: An (*) asterisk indicates that a wildcard value can be used with that
parameter (for mandatory fields, the wildcard value is an (*) asterisk). For Inbound
envelopes, a wildcard value in the envelope matches any value in the input
document, while an empty value in the envelope matches only an empty value in
the input document. For Outbound envelopes the wildcard value will be matched
with the values present in your custom business process, depending on the
Correlation Override Value set in the envelope.

The following table describes the Inbound SPEC2000 Message XML envelope
properties:

Field Description

* Customer Id Code/Reporting Organization Code
The code identifying the customer. Valid value is three to five standard
characters. Required.

* Supplier Code/Operator Code
The code identifying the supplier. Valid value is five standard characters.
Optional.

* Message Sender
The message sender as it should appear on the interchange header
segment sent to this company or division. Optional.

* Message Receiver
The message receiver as it should appear on the interchange header
segment sent to this company or division. Optional.

Message Type
The type of message. Select a message type from the list or choose
wildcard (*) to allow any message. Default is * (wildcard). Required.

Handling of non-compliant Messages
How non-compliant messages are handled. Valid values are Accept
compliant and non-compliant transactions and Accept compliant
transactions, reject non-compliant transactions (default).

Compliance Check Document
Check the document body for compliance. Valid values are Yes and No.
Required.

Map Name Mode
Mode in which to specify the map to use to perform a compliance check.
Valid values are:
v Specify
v Generate from data

Compliance Check Map Name
Which map to use to perform a compliance check. The map must already
be checked in. Select the map. Required if you selected Specify for Map
Name Mode.

Primary Name Format
Check boxes to instruct what information to include when generating and
matching a name for the map. Required.

Select from:
v Customer Id Code/Reporting Organization Code
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v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated map name (Map Name Mode is set to
Generate from data), Sterling B2B Integrator tries to generate and match
the following maps:
First, it tries to generate and match the map in the primary name format
(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.

First Backup Name Format
The first backup name format to use when generating a map name. The
system allows for two alternatives if the Primary Name Format is not
found-checking for the First Backup Name Format and then, if that is not
found, checking for the Second Backup Name Format. Optional.

Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated map name (Map Name Mode is set to
Generate from data), Sterling B2B Integrator tries to generate and match
the following maps:
First, it tries to generate and match the map in the primary name format
(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.

Second Backup Name Format
The second backup name format to use when generating a map name. The
system allows for two alternatives if the Primary Name Format is not
found-checking for the First Backup Name Format and then, if that is not
found, checking for the Second Backup Name Format. Optional.

Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
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v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated map name (Map Name Mode is set to
Generate from data), Sterling B2B Integrator tries to generate and match
the following maps:
First, it tries to generate and match the map in the primary name format
(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.

Generate an error if no generated map name exists in the system
Specifies whether to generate an error if the Map Name selected is not
found. Valid values are Yes (default) and No.

Note: Only displayed if Map Name Mode is set to Generate from data.

Keep translated document after compliance check
Whether to keep the translated document after performing the compliance
check. Valid values are Yes (default) and No. Required.

Validate translation output
Whether to validate the translation output. Valid values are Yes (default) or
No. Required.

Validate Schema of the map
Validates the document against the XSD for that message. Valid values are:
Yes (default) and No. Required.

Note: If you are using the Planning Evaluation Code (PLN) and Material
Evaluation Code (MLN), you must select No for this parameter and define
your own codelist with a combination of the codes in the schema (and use
the codelist you defined in the map).

Error business process name
How to determine which business process name to use if there were errors
in the compliance check. Required. Valid values are:
v Specify (default)
v Generate from data

Note: If you select the Generate from data option, you must select at least
one parameter for Primary Name Format.

Business Process for Non-Compliant Documents
Business process to be used when non-compliant documents are
encountered. Optional.

Displayed only if Error Business Process Name is set to Specify.

Primary Name Format
Check boxes to instruct what information to include when generating and
matching a name for the business process. Required.
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Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated business process name (Error Business
Process is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

First Backup Name Format
The first backup name format to use when generating a business process
name. The system allows for two alternatives if the Primary Name Format
is not found-checking for the First Backup Name Format and then, if that
is not found, checking for the Second Backup Name Format. Optional.

Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated business process name (Error Business
Process is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Second Backup Name Format
The second backup name format to use when generating a business
process name. The system allows for two alternatives if the Primary Name
Format is not found-checking for the First Backup Name Format and then,
if that is not found, checking for the Second Backup Name Format.
Optional.
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Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated business process name (Error Business
Process is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Generate an error if no generated business process name exists in the system
Specifies whether to generate an error if the Business Process selected is
not found. Valid values are Yes (default) and No.

Note: Only displayed if Error Business Process Name is set to Generate
from data.

Determine the business process by
How to determine which business process name to use if there were no
errors in the compliance check. Required. Valid values are:
v Specifying a business process (default)
v Generating the business process name from the data

Note: If you select the Generating the business process name from the
data option, you must select at least one parameter for Primary Name
Format.

Primary Name Format
Check boxes to specify which information to include when generating and
matching a name for the business process. Required.

Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated business process name (Determine the
Business Process By is set to Generating the business process name from
the data), Sterling B2B Integrator tries to generate and match the following
business process:
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v First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the
corresponding value in the message).

v Second, it tries to generate and match the first Backup Name.
v Third, it tries to generate and match the second Backup Name.
v Fourth, if there is not an existing business process that matches the

names generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

First Backup Name Format
The first backup name format to use when generating a business process
name. The system allows for two alternatives if the Primary Name Format
is not found-checking for the First Backup Name Format and then the
Second Backup Name Format. Optional.

Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated business process name (Determine the
Business Process By is set to Generating the business process name from
the data), Sterling B2B Integrator tries to generate and match the following
business process:
v First, it tries to generate and match the business process in the primary

name format (replacing the values that are selected for the
corresponding value in the message).

v Second, it tries to generate and match the first Backup Name.
v Third, it tries to generate and match the second Backup Name.
v Fourth, if there is not an existing business process that matches the

names generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Second Backup Name Format
The second backup name format to use when generating a business
process name. The system allows for two alternatives if the Primary Name
Format is not found-checking for the First Backup Name Format and then
the Second Backup Name Format. Optional.

Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type
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Note: If you are using a generated business process name (Determine the
Business Process By is set to Generating the business process name from
the data), Sterling B2B Integrator tries to generate and match the following
business process:
v First, it tries to generate and match the business process in the primary

name format (replacing the values that are selected for the
corresponding value in the message).

v Second, it tries to generate and match the first Backup Name.
v Third, it tries to generate and match the second Backup Name.
v Fourth, if there is not an existing business process that matches the

names generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Generate an error if no generated business process name exists in the system
Specify whether to generate an error if there is no match to the generated
business process name in the system. Valid values are Yes (default) and
No.

Note: Only displayed if Determine the Business Process By is set to
Generating the business process name from the data.

Business Process List
Select a previously created business process to associate with this envelope
Optional.

Displayed only if Determine the Business Process Name is set to
Specifying a business process.

Extraction Options
Business process data extraction. Required.

Valid values:
v Determined by business process (default)
v Extract to a file system directory
v Extract to a mailbox

Data Extraction Directory
Directory for data extraction. Optional.

Data Extraction Filename
Filename for data extraction. Optional.

Data Extraction Mailbox
Mailbox for data extraction. Required.

Data Extraction Mailbox Message Name
Mailbox message name for data extraction. Optional.

Signature Validation
Whether to validate the signature that the document contains. Valid values
are Required and Not Used (default). Required.

Signature Certificate
Select the signature certificate. Required.

Note: Only displayed if you selected Yes for Signature Validation.
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Outbound SPEC2000 ATA_Information Set Envelope

Note: An (*) asterisk indicates that a wildcard value can be used with that
parameter (for mandatory fields, the wildcard value is an (*) asterisk). For Inbound
envelopes, a wildcard value in the envelope matches any value in the input
document, while an empty value in the envelope matches only an empty value in
the input document. For Outbound envelopes the wildcard value will be matched
with the values present in your custom business process, depending on the
Correlation Override Value set in the envelope.

The following table describes the Outbound SPEC2000 ATA_Information Set
envelope properties:

Field Description

* Message Sender
The message sender as it should appear on the interchange header
segment sent to this company or division. Required.

* Message Receiver
The message receiver as it should appear on the interchange header
segment sent to this company or division. Required.

* Message ID
The message identifier. Required.

Use Correlation Overrides
Whether to use correlation overrides. Required. Valid values are:
v Always - If a correlation override value is provided, always use that

value instead of the value in the envelope (except for the Sender ID,
Receiver ID, and Sender/Receiver Qualifier fields, which must have a *
in the envelope definition to use the correlation override value).

v Only when the envelope field has a wildcard value (*) - Only use
correlation override values for fields in the envelope definition that are
specified with a wildcard (*).

v Never - Never use correlation overrides.
v Use the default specified in enveloping.properties - The

enveloping.properties file defines when to use correlation overrides if
this choice is selected. The properties file will either define Always,
Never, or Only when the envelope field has a wildcard (*) value. The
applicable properties file property is
enveloping.correl_override_default.[standard]. Allowed values are No
(which means never), WildcardOnly, or All (which means always, except
for the Sender ID, Receiver ID, and Sender/Receiver Qualifier fields,
which must have a * in the envelope definition to use the correlation
override value).

Determine the business process by
How to determine which business process name to use if there were no
errors in the compliance check. Required. Valid values are:
v Specifying a business process (default)
v Generating the business process name from the data

Note: If you select the Generating the business process name from the
data option, you must select at least one parameter for Primary Name
Format.
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Primary Name Format
Check boxes to specify which information to include when generating and
matching a name for the business process. Required.

Select from:
v Message Sender
v Message Receiver

Note: If you are using a generated business process name (Determine the
Business Process By is set to Generating the business process name from
the data), Sterling B2B Integrator tries to generate and match the following
business process:
v First, it tries to generate and match the business process in the primary

name format (replacing the values that are selected for the
corresponding value in the message).

v Second, it tries to generate and match the Backup Name.
v Third, if there is not an existing business process that matches the names

generated in steps 1-2, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Backup Name Format
The backup name format to use when generating a business process name.
Optional.

Select from:
v Message Sender
v Message Receiver

Note: If you are using a generated business process name (Determine the
Business Process By is set to Generating the business process name from
the data), Sterling B2B Integrator tries to generate and match the following
business process:
v First, it tries to generate and match the business process in the primary

name format (replacing the values that are selected for the
corresponding value in the message).

v Second, it tries to generate and match the Backup Name.
v Third, if there is not an existing business process that matches the names

generated in steps 1-2, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Generate an error if no generated business process name exists in the system
Specify whether to generate an error if there is no match to the generated
business process name in the system. Valid values are Yes (default) and
No.

Note: Only displayed if Determine the Business Process By is set to
Generating the business process name from the data.

Business Process List
Select a previously created business process to associate with this envelope
Optional.
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Displayed only if Determine the Business Process Name is set to
Specifying a business process.

Extraction Options
Business process data extraction. Required.

Valid values:
v Determined by business process (default)
v Extract to a file system directory
v Extract to a mailbox

Data Extraction Directory
Directory for data extraction. Optional.

Data Extraction Filename
Filename for data extraction. Optional.

Data Extraction Mailbox
Mailbox for data extraction. Required.

Data Extraction Mailbox Message Name
Mailbox message name for data extraction. Optional.

Outbound SPEC2000 Message XML Envelope

Note: An (*) asterisk indicates that a wildcard value can be used with that
parameter (for mandatory fields, the wildcard value is an (*) asterisk). For Inbound
envelopes, a wildcard value in the envelope matches any value in the input
document, while an empty value in the envelope matches only an empty value in
the input document. For Outbound envelopes the wildcard value will be matched
with the values present in your custom business process, depending on the
Correlation Override Value set in the envelope.

The following table describes the Outbound SPEC2000 Message XML envelope
properties:

Field Description

Next Envelope
Specifies the envelope to use after this envelope. Required.

Create New Envelope
Adds an envelope to use as next envelope or edits an existing envelope.
Optional.

Customer Id Code/Reporting Organization Code
The code identifying the customer. Valid value is three to five standard
characters. Optional.

Supplier Code/Operator Code
The code identifying the supplier. Valid value is five standard characters.
Optional.

* Message Sender
The message sender as it should appear on the interchange header
segment sent to this company or division. Required.

* Message Receiver
The message receiver as it should appear on the interchange header
segment sent to this company or division. Required.
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Message Type
The type of message. Select a message type from the list or choose
wildcard (*) to allow any message. Default is * (wildcard). Required.

Acceptor Lookup Alias
Alias for accepter lookup. Required.

Use Correlation Overrides
Whether to use correlation overrides. Required. Valid values are:
v Always - If a correlation override value is provided, always use that

value instead of the value in the envelope (except for the Sender ID,
Receiver ID, and Sender/Receiver Qualifier fields, which must have a *
in the envelope definition to use the correlation override value).

v Only when the envelope field has a wildcard value (*) - Only use
correlation override values for fields in the envelope definition that are
specified with a wildcard (*).

v Never - Never use correlation overrides.
v Use the default specified in enveloping.properties - The

enveloping.properties file defines when to use correlation overrides if
this choice is selected. The properties file will either define Always,
Never, or Only when the envelope field has a wildcard (*) value. The
applicable properties file property is
enveloping.correl_override_default.[standard]. Allowed values are No
(which means never), WildcardOnly, or All (which means always, except
for the Sender ID, Receiver ID, and Sender/Receiver Qualifier fields,
which must have a * in the envelope definition to use the correlation
override value).

Translate Message
Whether to automatically translate the message. Valid values are Yes
(default) and No. Required.

Map Name Mode
Mode in which to specify the map to use to perform the translation. Valid
values are:
v Specify
v Generate from data

Validate translation input
Whether to validate the translation input. Valid values are Yes (default) or
No. Required.

Validate translation output
Whether to validate the translation output. Valid values are Yes (default) or
No. Required.

Validate Schema of the map
Validates the document against the XSD for that message. Valid values are:
Yes (default) and No. Required.

Note: If you are using the Planning Evaluation Code (PLN) and Material
Evaluation Code (MLN), you must select No for this parameter and define
your own codelist with a combination of the codes in the schema (and use
the codelist you defined in the map).
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Compliance Check Map Name
Which map to use to perform the translation. The map must already be
checked in. Select the map. Required if you selected Specify for Map
Name Mode.

Primary Name Format
Check boxes to instruct what information to include when generating and
matching a name for the translation map. Required.

Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated map name (Map Name Mode is set to
Generate from data), Sterling B2B Integrator tries to generate and match
the following maps:
First, it tries to generate and match the map in the primary name format
(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.

First Backup Name Format
The first backup name format to use when generating a map name for
translation. The system allows for two alternatives if the Primary Name
Format is not found-checking for the First Backup Name Format and then,
if that is not found, checking for the Second Backup Name Format.
Optional.

Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated map name (Map Name Mode is set to
Generate from data), Sterling B2B Integrator tries to generate and match
the following maps:
First, it tries to generate and match the map in the primary name format
(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.
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Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.

Second Backup Name Format
The second backup name format to use when generating a map name for
translation. The system allows for two alternatives if the Primary Name
Format is not found-checking for the First Backup Name Format and then,
if that is not found, checking for the Second Backup Name Format.
Optional.

Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated map name (Map Name Mode is set to
Generate from data), Sterling B2B Integrator tries to generate and match
the following maps:
First, it tries to generate and match the map in the primary name format
(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.

Generate an error if no generated map name exists in the system
Specifies whether to generate an error if the Map Name selected is not
found. Valid values are Yes (default) and No.

Note: Only displayed if Map Name Mode is set to Generate from data.

Error business process mode
How to determine which business process name to use if there were errors
in the compliance check. Required. Valid values are:
v Specify (default)
v Generate from data

Note: If you select this option, you must select at least one parameter for
Primary Name Format.

Business Process for Non-Compliant Documents
Business process to be used when non-compliant documents are
encountered. Optional.

Displayed only if Error Business Process Mode is set to Specify.

Primary Name Format
Check boxes to instruct what information to include when generating and
matching a name for the business process. Required.

Select from:
v Customer Id Code/Reporting Organization Code
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v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated business process name (Error Business
Process is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

First Backup Name Format
The first backup name format to use when generating a business process
name. The system allows for two alternatives if the Primary Name Format
is not found-checking for the First Backup Name Format and then, if that
is not found, checking for the Second Backup Name Format. Optional.

Select from:
v Customer Id Code/Reporting Organization Code
v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated business process name (Error Business
Process is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Second Backup Name Format
The second backup name format to use when generating a business
process name. The system allows for two alternatives if the Primary Name
Format is not found-checking for the First Backup Name Format and then,
if that is not found, checking for the Second Backup Name Format.
Optional.

Select from:
v Customer Id Code/Reporting Organization Code
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v Supplier Code/Operator Code
v Message Sender
v Message Receiver
v Message Type

Note: If you are using a generated business process name (Error Business
Process is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Generate an error if no generated business process exists in the system
Specifies whether to generate an error if the business process selected is
not found. Valid values are Yes (default) and No.

Note: Only occurs if Error Business Process Mode is set to Generate from
data.

Generate Signature
Whether to generate a signature for the document. Valid values are Yes
and No (default). Required.

Signature Certificate
Select the signature certificate. Required.

Note: Only displayed if you selected Yes for Generate Signature.

Signature Algorithm
Select the signature algorithm. Required.

Note: Only displayed if you selected Yes for Generate Signature.

Outbound SPEC2000 CMD Outer Envelope

Note: An (*) asterisk indicates that a wildcard value can be used with that
parameter (for mandatory fields, the wildcard value is an (*) asterisk). For Inbound
envelopes, a wildcard value in the envelope matches any value in the input
document, while an empty value in the envelope matches only an empty value in
the input document. For Outbound envelopes the wildcard value will be matched
with the values present in your custom business process, depending on the
Correlation Override Value set in the envelope.

The following table describes the Outbound SPEC2000 CMD Outer envelope
properties:

Field Description
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Header
Specifies the message header. In the inbound side the Deenveloping service
parses the header and put the header you enter in the process data, if
present. Optional.

Note: This parameter can be overridden by the Correlation Service based
on the Correlation Overrides value (Out_SpecHeader is the tag).

Priority
Specifies the message priority. Optional.

Note: Enter two characters to set the priority in the outer outbound
envelope. This field must always start with Q (alphabetic capital letter).
This field can be overridden by the Correlation Service (Out_Priority is the
tag).

* Destination Address[Receiver ID]
The message receiver as it should appear on the interchange header
segment sent to this company or division. This is an alphanumeric
mandatory field of 7-8 characters length. Required.

Note: This parameter can be overridden by the Correlation Service based
on the Correlation Overrides Value (Out_Outer_ReceiverID is the tag). The
Inner Envelope ReceiverID can be simultaneously overridden by tag
Out_ReceiverID. Only the Outer Envelope parameters SenderID and
ReceiverID deviate from the standard convention out_<parm name>.

Additional Destination Address
An additional destination address. Optional.

Note: This field allows you to define additional addresses. In the message
header this field is appended to Destination Address, delimited by a
space.

Additional Destination Addresses Lines
Additional lines for the destination address. Optional.

Note: This field allows you to define additional addresses in multiple
lines. In the message header this field is appended in the second line of
destination addresses.

* Originator Address[Sender ID]
The message sender as it should appear on the interchange header
segment sent to this company or division. This is an alphanumeric
mandatory field of 7-8 characters length that is appended to the header.
Required.

Note: This parameter can be overridden by the Correlation Service based
on the Correlation Overrides Value (Out_Outer_SenderID is the tag). The
Inner Envelope SenderID can be simultaneously overridden by tag
Out_SenderID. Only the Outer Envelope parameters SenderID and
ReceiverID deviate from the standard convention out_<parm name>.

Date Time Format
The format of the date and time. Optional. Valid values are:
v None (default)
v Date Only (MMDDYY)
v Date Only (DDMMYY)

Chapter 3. SPEC2000 Enveloping 37



v Date Only (YYMMDD)
v Date Only (YYYYMMDD)
v Time Only (HHMMSS)
v Date and Time (YYYYMMDDHHMMSS)
v Custom Format

Note: If you choose Custom Format, you must provide a format in the
Custom Date Time Format envelope field.

Custom Date Time Format
The value that will be appended to the SenderID, delimited by the
parameter specified in Delimiter for Additional Message Identity.
Required. This parameter is only displayed if you select Custom Format
for Date Time Format.

Delimiter for Additional Message Identity
A delimiter used for additional message identity. Optional. Valid values
are:
v None (default)
v Hyphen (-)
v Slash (/)
v Space ( )
v Dot (.)

Additional Message Identity
The additional message identity, if any. This is a free-form field in which
you can enter any string. This String is appended to the Date/Time field,
delimited by the above selected delimiter (Delimiter for Additional
Message Identity) to form the message Identity.

Note: Correlation override may be used with this field, using the tag
Out_AdditionalMessageIdentity.

If you choose None for the Date Time Format parameter, only this field is
used to construct the Message Identity.

Optional.

Communications Service Code
The communications service code. Optional. Valid values are:
v None (default)
v PDM (Possible Duplicate Message)
v COR (Correction)
v QTA (Message Interrupted - Will Be Resent)
v QTB (Message Interrupted - Will Not Be Resent)
v INT (Intercepted Message)
v * (wildcard)

Note: This field can also be overridden by the Correlation Service with the
Out_CommunicationServiceCode .

Exclude Standard Message Identifier (CAM)
If selected, specifies to exclude the standard message identifier (CAM).
Default is not selected, which indicates that the CAM will not be included
in the header.
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Include End of the Message Character in the Message
If selected, specifies to include the end of the message (LF LF LF and EOT)
characters. Default is not selected. Characters CR LF are added to the
header and the transmission control characters SOH, STX and ETX will
also be added regardless of what you select for this parameter.

Use Correlation Overrides
Whether to use correlation overrides. Required. Valid values are:
v Always - If a correlation override value is provided, always use that

value instead of the value in the envelope (except for the Sender ID,
Receiver ID, and Sender/Receiver Qualifier fields, which must have a *
in the envelope definition to use the correlation override value).

v Only when the envelope field has a wildcard value (*) - Only use
correlation override values for fields in the envelope definition that are
specified with a wildcard (*).

v Never - Never use correlation overrides.
v Use the default specified in enveloping.properties - The

enveloping.properties file defines when to use correlation overrides if
this choice is selected. The properties file will either define Always,
Never, or Only when the envelope field has a wildcard (*) value. The
applicable properties file property is
enveloping.correl_override_default.[standard]. Allowed values are No
(which means never), WildcardOnly, or All (which means always, except
for the Sender ID, Receiver ID, and Sender/Receiver Qualifier fields,
which must have a * in the envelope definition to use the correlation
override value).

Specify the Supplementary Address
Whether the supplementary address must be specified. Valid values are Yes
and No (default). Required.

S1FRADDR/A1FRADDR
Allows you to specify the supplementary address. Optional.

S1TOADDR/A1TOADDR
Allows you to specify the supplementary address. Optional.

Limit Interchange Size
Specifies whether the interchange size should be limited. Based on the
value set in Maximum Interchange Size limit, the interchange will be split
into multiple if it contains more than the value specified.

Valid values are:
v No
v Specify size limit
v Use global default in enveloping.properties (default)

Required.

Note: When Use global default in enveloping.properties (which is the
default) is selected, Sterling B2B Integrator does not display the Maximum
Interchange Size (bytes) parameter, because It picks up the value from the
enveloping.properties file. The enveloping.properties file contains a
property for each supported standard and more specific properties for each
message type that can override the standard property.
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Invoke Business Process for Each Interchange
Whether a business process is invoked for each interchange generated.
Valid values are Yes and No (default). Required.

Note: If Invoke Business Process for Each Interchange is set to No, the
service places the name of the business process specified in the envelope
into process data using the key WFD_NAME. This business process is then
invoked by the Invoke Business Process Service. If Invoke Business Process
For Each Interchange is set to Yes, the service directly bootstraps an
instance of the business process specified in the envelope, and does not set
WFD_NAME in process data.

Maximum Interchange Size (bytes)
Specify the maximum size of each individual interchange. Required.

Note: Only displayed if you selected Specify size limit for the Limit
Interchange Size parameter. The default value specified by the SPEC2000
standard is 3480 bytes.

Determine the business process by
How to determine which business process name to use if there were no
errors in the compliance check. Required. Valid values are:
v Specifying a business process (default)
v Generating the business process name from the data

Note: If you select the Generating the business process name from the
data option, you must select at least one parameter for Primary Name
Format.

Primary Name Format
Check boxes to specify which information to include when generating and
matching a name for the business process. Required.

Select from:
v Originator Address
v Destination Address

Note: If you are using a generated business process name (Determine the
Business Process By is set to Generating the business process name from
the data), Sterling B2B Integrator tries to generate and match the following
business process:
v First, it tries to generate and match the business process in the primary

name format (replacing the values that are selected for the
corresponding value in the message).

v Second, it tries to generate and match the Backup Name.
v Third, if there is not an existing business process that matches the names

generated in steps 1-2, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Backup Name Format
The backup name format to use when generating a business process name.
The system allows for two alternatives if the Primary Name Format is not
found-checking for the Backup Name Format. Optional.

Select from:
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v Originator Address
v Destination Address

Note: If you are using a generated business process name (Determine the
Business Process By is set to Generating the business process name from
the data), Sterling B2B Integrator tries to generate and match the following
business process:
v First, it tries to generate and match the business process in the primary

name format (replacing the values that are selected for the
corresponding value in the message).

v Second, it tries to generate and match the first Backup Name.
v Third, if there is not an existing business process that matches the names

generated in steps 1-2, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Generate an error if no generated business process name exists in the system
Specify whether to generate an error if there is no match to the generated
business process name in the system. Valid values are Yes (default) and
No.

Note: Only displayed if Determine the Business Process By is set to
Generating the business process name from the data.

Business Process List
Select a previously created business process to associate with this envelope
Optional.

Displayed only if Determine the Business Process Name is set to
Specifying a business process.

Extraction Options
Business process data extraction. Required.

Valid values:
v Determined by business process (default)
v Extract to a file system directory
v Extract to a mailbox

Data Extraction Directory
Directory for data extraction. Optional.

Data Extraction Filename
Filename for data extraction. Optional.

Data Extraction Mailbox
Mailbox for data extraction. Required.

Data Extraction Mailbox Message Name
Mailbox message name for data extraction. Optional.

Outbound SPEC2000 Command Message Envelope

Note: An (*) asterisk indicates that a wildcard value can be used with that
parameter (for mandatory fields, the wildcard value is an (*) asterisk). For Inbound
envelopes, a wildcard value in the envelope matches any value in the input
document, while an empty value in the envelope matches only an empty value in
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the input document. For Outbound envelopes the wildcard value will be matched
with the values present in your custom business process, depending on the
Correlation Override Value set in the envelope.

The following table describes the Outbound SPEC2000 Command Message
envelope properties:

Field Description

Next Envelope
Specifies the envelope to use after this envelope. Required.

Create New Envelope
Adds an envelope to use as next envelope or edits an existing envelope.
Optional.

Customer Id Code
The code identifying the customer. Valid value is three to five standard
characters. Optional.

Supplier Code
The code identifying the supplier. Valid value is five standard characters.
Optional.

* Originator Address[Sender ID]
The message sender as it should appear on the interchange header
segment sent to this company or division. This is an alphanumeric
mandatory field of 7-8 characters length that is appended to the header.
Required.

* Destination Address[Receiver ID]
The message receiver as it should appear on the interchange header
segment sent to this company or division. This is an alphanumeric
mandatory field of 7-8 characters length. Required.

Message Type
The type of message. Select a message type from the list or choose
wildcard (*) to allow any message. Default is * (wildcard). Required.

Acceptor Lookup Alias
Alias for accepter lookup. Required.

Use Correlation Overrides
Whether to use correlation overrides. Required. Valid values are:
v Always - If a correlation override value is provided, always use that

value instead of the value in the envelope (except for the Sender ID,
Receiver ID, and Sender/Receiver Qualifier fields, which must have a *
in the envelope definition to use the correlation override value).

v Only when the envelope field has a wildcard value (*) - Only use
correlation override values for fields in the envelope definition that are
specified with a wildcard (*).

v Never - Never use correlation overrides.
v Use the default specified in enveloping.properties - The

enveloping.properties file defines when to use correlation overrides if
this choice is selected. The properties file will either define Always,
Never, or Only when the envelope field has a wildcard (*) value. The
applicable properties file property is
enveloping.correl_override_default.[standard]. Allowed values are No
(which means never), WildcardOnly, or All (which means always, except

42 Sterling Standards Library: Using SPEC2000



for the Sender ID, Receiver ID, and Sender/Receiver Qualifier fields,
which must have a * in the envelope definition to use the correlation
override value).

Expect an acknowledgement
Whether you expect an acknowledgement that notifies the receiver has
received an interpretable document. Valid values are Yes and No (default).
Required.

Acknowledgement overdue time (hours)
Amount of time, in hours, within which you must receive an
acknowledgement. Valid value is four numeric characters. Optional.

Acknowledgement overdue after (minutes)
Amount of time, in minutes, within which you must receive an
acknowledgement. Valid value is four numeric characters. Optional.

Generate control number
Whether to generate a control number. Valid values are:
v Yes (default)
v Yes (and generate from data)
v No

Specify whether to Override the Acknowledgement number in transaction with
control number

Whether to override the acknowledgement number in the transaction with
the control number. Valid values are Yes and No (default).

Global Transaction Set Control Number
Transaction set control reference used globally. Select a previously defined
global transaction set control reference. Valid value is up to 16 standard
characters. Required.

Primary Name Format
Check boxes to instruct what information to include when generating and
matching a control number. Required.

Select from:
v Customer Id Code
v Supplier Code
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated control number (Generate Control
Number is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following control numbers:
First, it tries to generate and match the control number in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing control number that matches the names
generated in steps 1-3, a new global control number will be created.

First Backup Name Format
The first backup name format to use when generating a control number for
translation. The system allows for two alternatives if the Primary Name
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Format is not found-checking for the First Backup Name Format and then,
if that is not found, checking for the Second Backup Name Format.
Optional.

Select from:
v Customer Id Code
v Supplier Code
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated control number (Generate Control
Number is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following control numbers:
First, it tries to generate and match the control number in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing control number that matches the names
generated in steps 1-3, a new global control number is created.

Second Backup Name Format
The second backup name format to use when generating a control number
for translation. The system allows for two alternatives if the Primary Name
Format is not found-checking for the First Backup Name Format and then,
if that is not found, checking for the Second Backup Name Format.
Optional.

Select from:
v Customer Id Code
v Supplier Code
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated control number (Generate Control
Number is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following control numbers:
First, it tries to generate and match the control number in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing control number that matches the names
generated in steps 1-3, a new global control number is created.

Translate Message
Whether to automatically translate the message. Valid values are Yes
(default) and No. Required.

Map Name Mode
Mode in which to specify the map to use to perform a compliance check.
Valid values are:
v Specify
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v Generate from data

Validate translation input
Whether to validate the translation input. Valid values are Yes (default) or
No. Required.

Validate translation output
Whether to validate the translation output. Valid values are Yes (default) or
No. Required.

Map Name
Which map to use to perform the translation. The map must already be
checked in. Select the map. Required if you selected Specify for Map
Name Mode.

Primary Name Format
Check boxes to instruct what information to include when generating and
matching a name for the map. Required.

Select from:
v Customer Id Code
v Supplier Code
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated map name (Map Name Mode is set to
Generate from data), Sterling B2B Integrator tries to generate and match
the following maps:
First, it tries to generate and match the map in the primary name format
(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.

First Backup Name Format
The first backup name format to use when generating a map name. The
system allows for two alternatives if the Primary Name Format is not
found-checking for the First Backup Name Format and then, if that is not
found, checking for the Second Backup Name Format. Optional.

Select from:
v Customer Id Code
v Supplier Code
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated map name (Map Name Mode is set to
Generate from data), Sterling B2B Integrator tries to generate and match
the following maps:
First, it tries to generate and match the map in the primary name format
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(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.

Second Backup Name Format
The second backup name format to use when generating a map name. The
system allows for two alternatives if the Primary Name Format is not
found-checking for the First Backup Name Format and then, if that is not
found, checking for the Second Backup Name Format. Optional.

Select from:
v Customer Id Code
v Supplier Code
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated map name (Map Name Mode is set to
Generate from data), Sterling B2B Integrator tries to generate and match
the following maps:
First, it tries to generate and match the map in the primary name format
(replacing the values that are selected for the corresponding value in the
message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing map that matches the names generated in
steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated map name exists
in the system is set to Yes.

Generate an error if no generated map name exists in the system
Specifies whether to generate an error if the Map Name selected is not
found. Valid values are Yes (default) and No.

Note: Only displayed if Map Name Mode is set to Generate from data.

Error business process mode
How to determine which business process name to use if there were errors
in the compliance check. Required. Valid values are:
v Specify (default)
v Generate from data

Note: If you select this option, you must select at least one parameter for
Primary Name Format.

Business Process for Non-Compliant Documents
Business process to be used when non-compliant documents are
encountered. Optional.

Displayed only if Error Business Process Name is set to Specify.
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Primary Name Format
Check boxes to instruct what information to include when generating and
matching a name for the business process. Required.

Select from:
v Customer Id Code
v Supplier Code
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated business process name (Error Business
Process is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

First Backup Name Format
The first backup name format to use when generating a business process
name. The system allows for two alternatives if the Primary Name Format
is not found-checking for the First Backup Name Format and then, if that
is not found, checking for the Second Backup Name Format. Optional.

Select from:
v Customer Id Code
v Supplier Code
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated business process name (Error Business
Process is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Second Backup Name Format
The second backup name format to use when generating a business
process name. The system allows for two alternatives if the Primary Name

Chapter 3. SPEC2000 Enveloping 47



Format is not found-checking for the First Backup Name Format and then,
if that is not found, checking for the Second Backup Name Format.
Optional.

Select from:
v Customer Id Code
v Supplier Code
v Originator Address
v Destination Address
v Message Type

Note: If you are using a generated business process name (Error Business
Process is set to Generate from data), Sterling B2B Integrator tries to
generate and match the following business processes:
First, it tries to generate and match the business process in the primary
name format (replacing the values that are selected for the corresponding
value in the message).
Second, it tries to generate and match the First Backup Name.
Third, it tries to generate and match the Second Backup Name.
Fourth, if there is not an existing business process that matches the names
generated in steps 1-3, an error is generated.

Note: Only occurs if Generate an error if no generated business process
name exists in the system is set to Yes.

Generate an error if no generated map name exists in the system
Specifies whether to generate an error if the Map Name selected is not
found. Valid values are Yes (default) and No.

Note: Only occurs if Error Business Process Name is set to Generate from
data.
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Chapter 4. Creating SPEC2000 Maps

The Sterling B2B Integrator Map Editor enables you to map SPEC2000 documents,
and generates a file layout for you using the components and message types that
you select. The Sterling B2B Integrator Map Editor-generated SPEC2000 map
consists of map components that are comparable to parameters that are defined by
SPEC2000.

Note: You need to download the Sterling B2B Integrator Map Editor component to
use it.

Sterling B2B Integrator Map Editor allows you to modify the map components by
using the Deactivate, Promote, Split, Copy, Cut, and Paste functions.

You can create a map for the SPEC2000 online messages and batch files that are
loaded as DDF files as part of the Sterling B2B Integrator Map Editor installation.
The data definition format (DDF) is a Sterling Commerce™ format that contains an
XML-formatted description of the input or output side of a source map and has
the file extension .ddf. The extended rules for the DDF files are extracted from the
standards database that is downloaded when you download and install the
Sterling B2B Integrator Map Editor.

SPEC2000 messages are also loaded using schema for XML messages. Additionally,
you can create maps for customized messages.

Note: The field lengths in the Sterling B2B Integrator Map Editor preloaded DDFs
are same as the lengths in the ATA schemas, not the field lengths that are defined
for the corresponding command messages in the specification.

SPEC2000 Components in the Sterling B2B Integrator Map Editor

The following table lists the components that make up the SPEC2000 layout in the
Sterling B2B Integrator Map Editor, the icons that represent the components, and
descriptions of the components. .

Component Icon Description

SPEC2000
root element

The SPEC2000 root element represents the message that Sterling B2B
Integrator is mapping. At the SPEC2000 file root element, you
define the message type and encoding. It is a group and can
contain groups and records.

Group A group is a looping structure that contains a sequence or an
implicit group of repeating field tags (in Sterling B2B Integrator
Map Editor a group is related segments and groups that repeat in
sequence until either the group data ends, or the maximum number
of times that the loop is permitted to repeat is exhausted).

A group that is subordinate to another group is a subgroup (and
corresponds to a nested looping structure, a loop within a loop).

When a group contains an extended rule or a standard rule, an
asterisk appears to the right of the group icon.
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Component Icon Description

Segment A SPEC2000 segment contains a field tag (in Sterling B2B Integrator
Map Editor, a SPEC2000 segment is a group of related elements that
combine to communicate useful data). A SPEC2000 segment can
occur once or can repeat multiple times.
Note: If a SPEC2000 segment occurs more than once in a map, it is
identified by its name <ID>. The second and subsequent
occurrences are identified by <ID>:n, where n is the number of the
occurrence in the map.

Element An element is a field or a group of SPEC2000 components (the
smallest piece of information defined by the standard) that define a
SPEC2000 element. An element can have different meanings
depending on the context. In other data formats in the Sterling B2B
Integrator Map Editor, an element is not considered to have useful
meaning except in the larger context of the segment that contains it.
However, elements used in the Sterling B2B Integrator Map Editor
to represent SPEC2000 fields and components contain useful and
discrete information.
Note: If an element occurs more than once in a map it is identified
by its name <ID>. The second and subsequent occurrences are
identified by <ID>:n, where n is the number of the occurrence in
the map.

A repeating element is an element with the ability to loop (occur
more than once) within a particular SPEC2000 segment. To enable a
single element to repeat multiple times within a SPEC2000 element,
the occurrence of the element must be separated by a start and end
delimiter. The use of start and end delimiters help the translator
determine where elements and components are defined within a
field tag.

When a field has a link performed against it, a red check mark
appears over the element icon.

When a field contains an extended rule or a standard rule, an
asterisk appears to the right of the element icon.

Creating a SPEC2000 Map Using Preloaded Messages in the Sterling
B2B Integrator Map Editor

About this task

When you create a new map, you can use a wizard that creates a layout for you
based on the standard. The wizard saves you time and effort and minimizes the
risk of having an invalid standard format.

When you create a map, for both the input and output sides, you choose whether
you want to use a preloaded standard, an existing file format, or want to create a
new file format for that side of the map (including selecting from standards that
you have previously downloaded to the standards database). The preloaded
standards are downloaded when you download the Sterling B2B Integrator Map
Editor to your machine, as well as any optional standards such as the SWIFT MX
standards and those included with the Financial Services XML Standards bundle,
and include the following:

Note: For a complete list of the preloaded standards consult the New Map Wizard.
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Note: If the map you are creating contains greater than 20,000 objects, you will
receive a message noting that this map contains a very large number of objects. For
best performance, it is recommended that you consider whether any unnecessary
objects in the map can be removed, do not expand the entire object tree—expand
only the section of the tree you are currently mapping, consider using the Show
links to or from the currently selected element option instead of the Show links
to or from all visible elements option, and save the map using the .MAP file
format (using the Save As function).

To create a SPEC2000 map using the preloaded messages in Sterling B2B Integrator
Map Editor:

Procedure
1. From the Sterling B2B Integrator Map Editor File menu, select New.
2. In the New Map Wizard, complete the questions in the first window and click

Next.

Results

Note: Be sure thatSterling B2B Integrator is selected in the What kind of map are
you creating list.

Creating a SPEC2000 Map Using Customized Messages
About this task

When you create a new map, you can use a wizard that creates a layout for you
based on the standard. The wizard saves you time and effort and minimizes the
risk of having an invalid standard format.

Note: If the map you are creating contains greater than 20,000 objects, you will
receive a message noting that this map contains a very large number of objects. For
best performance, it is recommended that you consider whether any unnecessary
objects in the map can be removed, do not expand the entire object tree—expand
only the section of the tree you are currently mapping, consider using the Show
links to or from the currently selected element option instead of the Show links
to or from all visible elements option, and save the map using the .MAP file
format (using the Save As function).

To create a SPEC2000 map using customized messages in Sterling B2B Integrator
Map Editor:

Procedure
1. From the Sterling B2B Integrator Map Editor File menu, select New.
2. In the New Map Wizard, complete the questions in the first window and click

Next.

Note: Be sure thatSterling B2B Integrator is selected in the What kind of map
are you creating list.

3. If you are translating from SPEC2000, in the Input Format window select the
Create a New Data Format Using this Syntax option.

4. Then, select SPEC2000 (E-Business Specification for Materials Management)
and click Customize. If you are translating from another format, select that
format and continue to the next page of the wizard.

Chapter 4. Creating SPEC2000 Maps 51



5. If you selected SPEC2000, choose the type of message to auto-generate
(BATCH FILES, ONLINE MESSAGES, or XML MESSAGES) and click Next.

6. Select the ODBC data source that contains the SPEC2000 standards database
(for SPEC2000 for BATCH FILES and ONLINE MESSAGES only, select
SPEC2000 Standard; for other formats, select Sterling Integrator Standards)
and click Next.

7. Select the version and message or file type that you want to use and click
Next.

8. Click Finish to load the message.
9. Click Next to select the Output Format.

10. If you are translating from SPEC2000, in the Output Format window select the
Create a New Data Format Using this Syntax option.

11. Then, select SPEC2000 (E-Business Specification for Materials Management)
and click Customize. If you are translating from another format, select that
format and continue to the next page of the wizard.

12. If you selected SPEC2000, choose the type of message to auto-generate
(BATCH FILES, ONLINE MESSAGES, or XML MESSAGES) and click Next.

13. Select the ODBC data source that contains the SPEC2000 standards database
(for SPEC2000 for BATCH FILES and ONLINE MESSAGES only), select
SPEC2000 Standard; for other formats, select Sterling Integrator Standards)
and click Next.

14. Select the version and message or file type that you want to use and click
Next.

15. Click Finish to load the message.
16. The Sterling B2B Integrator Map Editor displays the new map in the Sterling

B2B Integrator Map Editor window.
17. In the Sterling B2B Integrator Map Editor, select File > Save to save the map.

Do not use spaces or apostrophes in the map name.

Note: To compile the map, select File > Compile. A progress dialog box
displays and updates during the compilation process. If the map contains a
large number of objects, you may be prompted that you should save the map
in .MAP format.

18. To save a map as a .map file, select File > Save As and then select Source
Maps (*.map) from the Save as type list.

Results

Note: Prior to opening an .mxl (XML-formatted) file, the Sterling B2B Integrator
Map Editor verifies that you have the Microsoft XML Core Services (MSXML) 4.0
installed on the same computer as Sterling B2B Integrator Map Editor. If you do
not have the Microsoft XML Core Services (MSXML) 4.0 installed, the Sterling B2B
Integrator Map Editor cannot save or load .mxl source files.

XML Data Format
If you select XML MESSAGES as the format for your map, the Sterling B2B
Integrator Map Editor XML implementation conforms to the rules of the XML
language 1.0 specification, as published by the World Wide Web Consortium
(W3C). However, to be more flexible, Sterling B2B Integrator Map Editor and the
translator diverges slightly from the W3C base 1.0 XML specification. The Sterling
B2B Integrator Map Editor implementation enables you to do the following with
XML:
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v Specify the number of times that a group can repeat.
v Specify the number of times an element in a mixed group can repeat.
v Repeat an element (with a structure different from the structure of the original

element) in a different part of the document.

XML Components

The following table lists the components that make up the XML message layout in
the Sterling B2B Integrator Map Editor, the icons that represent the components,
and descriptions of the components.

Component Icon Description

XML root
element

The XML root element represents the XML document that is being
mapped. The XML root element is a looping structure that contains
elements and content particles that repeat in sequence until either
the group data ends or the maximum number of times that the loop
is permitted to repeat is exhausted. The root element cannot be
referenced by standard rules or links.

Element An element contains related elements and content particles. In
addition, an element can contain one pcdata and one attribute
container. These objects repeat in sequence until either the element
data ends or the maximum number of times that the loop is
permitted to repeat is exhausted. A repeating element that contains
another repeating element corresponds to a nested looping
structure. The XML Element object cannot be referenced by
standard rules or links.

Abstract
element

An abstract element is an inconcrete element from an XML schema
(for example, the term “appliance” may be considered an abstract
element while “dishwasher” is a concrete one). An abstract element
must be substituted with a non-abstract element for a map to be
successfully compiled.

Content
particle

A content particle contains related subordinate objects that define
either a choice, a sequence, or an all. A content particle can contain
only one pcdata. If specified, these objects can repeat in sequence
until either the content particle data ends or the maximum number
of times that the loop is permitted to repeat is exhausted. If you
create a content particle that is subordinate to another content
particle, the content particle corresponds to a nested looping
structure (a loop within a loop). A content particle cannot be
referenced by standard rules or links.

Pcdata A pcdata contains character data in an XML document. Only one
pcdata can be defined per element or content particle. Sterling B2B
Integrator Map Editor automatically names the pcdata with the
name of the parent element or content particle.

When a pcdata has a link performed against it, a red check mark
appears over the pcdata icon.

When a pcdata contains an extended rule or a standard rule, an
asterisk appears to the right of the pcdata icon.
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Component Icon Description

Attribute
container

An attribute container does not correspond to an XML function.
Sterling B2B Integrator Map Editor uses attribute containers to
contain the attributes of an XML element. The attribute container
has no properties. When you create the first attribute of an XML
element, the Sterling B2B Integrator Map Editor automatically
creates an attribute container object. An element can have only one
attribute container, but the attribute container object can enclose
many attribute objects.

Attribute An attribute specifies information associated with an element that
further defines the element. The attribute is located within an
attribute container. Attributes do not have to occur in sequence in
the input data.

When an attribute has a link performed against it, a red check mark
appears over the attribute icon.

When an attribute contains an extended rule or a standard rule, an
asterisk appears to the right of the attribute icon.

XML Considerations
Before you create an XML layout, consider:
v You have two options for creating an XML layout: manually create an XML

layout or create an XML layout from a document type definition (DTD) or XML
schema.

v If you are using an XML schema, you must install the following software. Both
are available from the Microsoft Web site.
– Microsoft XML Core Services 4.0 RTM (XML parser)
– Windows Installer 2.0 (to install the preceding XML parser)

An XML schema defines rules for the structure and content of an XML document.
The schema you use must meet schema standards. Only valid schemas will
generate an XML map structure.

Note: Verify the schema is valid by using a Schema Validator.

Support for XML Schemas
The Translation service uses the Xerces 1.4.3 XML parser, which supports the W3C
XML Schema recommendation version 1.0.

Note: Because of how the Xerces XML parser handles elements with complex
content, it is best to modify the schema to use unbounded instead of maxOccurs
with large values and to avoid using large values for minOccurs. Otherwise, you
may see a StackOverflowError from the Xerces parser during translation.

The Sterling B2B Integrator Map Editor uses the Microsoft XML Core Services 4.0
RTM (XML parser) to read and validate XML schemas. The Sterling B2B Integrator
Map Editor does not display the following features of XML schemas:
v Substitution groups
v Data type facets other than minimum and maximum length
v Abstract element types (for more information about how abstract element types

are supported in the Sterling B2B Integrator Map Editor, see “Abstract Elements
and Sterling B2B Integrator Map Editor” on page 55)
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v Data type derivations
v The Sterling B2B Integrator Map Editor uses XML schemas to create the initial

file format. You cannot create a new element after importing a schema by
referring to a type defined in the schema.

v Annotations
v Prohibited attribute constraints
v The nillable, fixed-value, and default value attributes of an element

The Sterling B2B Integrator Map Editor supports the following XML schema
features, and:
v Treats list data types as strings
v Creates a code list to contain the enumeration values of a simple type derived

by enumeration
v If a simple data type is derived by the union of differing integral types, treats

the data type as a string (for example, a date/time type joined with an integer
type would be treated as a string)

v The translator currently wraps a CDATA section around any text that contains
one of the five special characters (< (less than), > (greater than), & (ampersand), '
(single quote or apostrophe), and “ (double quote)

Abstract Elements and Sterling B2B Integrator Map Editor
An abstract element is an non-concrete element from an XML schema (for example,
the term “appliance” may be considered an abstract element while “dishwasher” is
a concrete one). An abstract element must be substituted with a non-abstract
element for a map to be successfully compiled. For more information about
changing an abstract element to an XML element, see “Creating an Element” on
page 62.

Note: Abstract elements are reported during map compilation as Warnings.

Creating an XML Layout from a DDF File
The data definition format (DDF) is a Sterling Commerce format that contains an
XML-formatted description of the input or output side of a source map and has
the file extension .ddf. DDF files include the hierarchical and looping structure of
the data, the map objects (groups, records, fields) and their attributes (for example,
names, descriptions, data types). A DDF file can be loaded (imported) or created
(for export) from the Sterling B2B Integrator Map Editor.

Note: DDF files do not contain standard or extended rules, links, or any other map
information unrelated to the data format. The exceptions are the Use Code and Use
Constant code lists. If the map references a Use Code or Use Constant standard
rule and instructs the translator to raise a compliance error if the code is not found
in the Use Code or Use Constant code list, the translator saves the standard rule
and the associated code list.

DDF files support constants by using attributes. A typical example of attributes is
as follows:
USECONSTANT="yes" CONSTANTID="0" CONDITIONALFIELDID="-1"

The fields and attributes are present at the Field level in a DDF file. Therefore,
when constants (a type of standard rule) are used in the map, and you have saved
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that map as a DDF file, the DDF file also contains the attributes, and when you
open this DDF file those constants below are applied to their respective fields.

Constant
Attribute

USECONSTANT
This attribute will show whether constant is used for that particular field.
Values will be Yes or No.

CONSTANTID
This attribute is similar to ConstantID tag in the mxl file.

CONDITIONALFIELDID
This attribute is similar to ConditionalFieldID tag in the mxl file.

Requirement for Using DDF Files
Because DDF files are formatted in XML, you must have the Microsoft XML Core
Services (MSXML) 4.0 installed on the same computer as the Sterling B2B
Integrator Map Editor. You can obtain Microsoft XML Core Services (MSXML) 4.0
by installing the most current release of Microsoft Internet Explorer. If you do not
have the Microsoft XML Core Services (MSXML) 4.0 installed, the Sterling B2B
Integrator Map Editor cannot support DDF files.

Opening a DDF File
About this task

Sterling B2B Integrator Map Editor enables you to open, or import, a DDF file in
two ways—when you create a new map, and when you open a DDF file into one
side of an existing map. Either way, using a DDF file provides you with a quick
way to create either side of a map.

When you create a new map, the New Map wizard enables you to select a DDF
file to use as the basis for the input or output side of the map. When you open a
DDF file, Sterling B2B Integrator Map Editor assigns acceptable defaults if
attributes are not included. For example, if a value is not specified for Minimum
Length, a value of zero is assigned.

To open a DDF (including the BECS DDFs that are preloaded with Sterling B2B
Integrator Map Editor) file into an existing map:

Note: Opening a DDF file into an existing map replaces the selected side of the
map. After you open a DDF file into a map, you cannot undo the operation.

Procedure
1. In the Sterling B2B Integrator Map Editor, right-click the data format icon on

the side of the map where you want to open the DDF file and select Open File
Definition from the shortcut menu.

Note: If you already used Sterling B2B Integrator Map Editor to create that
side of the map, you are prompted with a message that warns you that the
existing file format will be replaced. Click Yes to continue.

2. Browse to locate the DDF file.
3. Click Open to open the selected DDF file into the map.
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Creating a DDF File
About this task

Sterling B2B Integrator Map Editor enables you to create (save as a DDF/IFD) a
DDF file so that you can use it as a starting place in other maps or as a means to
update existing maps.

To create a DDF file:

Procedure
1. In the Sterling B2B Integrator Map Editor, right-click the data format icon on

the side of the map from which you want to create a DDF file and select Save
File Definition As from the shortcut menu.

2. Browse to the location where you want to save the DDF file.
3. Click Save to save the DDF file.

Creating an XML Layout from a DTD or Schema
About this task

When you create a new map, you can either manually create an XML layout or
you can use a wizard that creates a layout for you based on a DTD or schema.

The wizard performs the following tasks:
v Raises a warning if it encounters attributes that use entities or notations
v Changes attributes of type ENTITY or ENTITIES to type CDATA
v Changes attributes of type NOTATION to type ENUMERATED
v Disregards comments and processing instructions
v Discards external entities and notations
v Does not support XML namespaces for DTDs or conditional sections
v Supports internal and external parameter entities
v Supports external parameter entities that reference a URL only if Microsoft®

Internet Explorer 3.0 or later is installed on the computer

To create an XML layout from a DTD or schema:

Procedure
1. From the Sterling B2B Integrator Map EditorFile menu, select New.
2. In the New Map Wizard, complete the questions on the first screen.

Note: To use XML schemas, the map type must be Sterling B2B Integrator.
3. If you are translating from XML, from the Create a new data format using

this syntax list, select XML and click Customize. If you are translating from
another format, select that format and continue to the next screen.

4. In the New XML Wizard, select the Customization File Type—the type of file
you want to use to create your XML layout, either DTD or XML schema.

5. Type the name of the DTD or XML schema, type the URL, or browse to the
location of the DTD or XML schema, and click Next.

6. Select the root element. The DTD or schema does not explicitly define the root
element, so you can select from all the elements defined in the DTD or all the
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top-level elements defined in the .XSD schema (elements subordinate to the
schema element). By default, the wizard selects the first element it encounters.

7. Specify the maximum length for data elements. For a DTD, you can specify
the maximum length of data elements because length is not defined in the
DTD and is optional for elements declared in the XML schema. For an XML
schema, the maximum length can be specified for some elements. You can
specify a default field length for elements that do not have a specified field
length.

8. If you want the map to contain code lists equivalent to the enumerations
defined in the DTD or schema, select the Build code lists for enumerated
attributes check box.

Note: The default for the Build code lists for enumerated attributes check box
is cleared because using code lists may be redundant and thus your map is
smaller and more efficient without them.

9. Click Next.
10. If you chose to import an XML schema, select the subelements you want to be

included in the map, and click Next.

Note: The list displays the entire tree of elements and subelements for the
root element you selected, hierarchically displayed using indentation.
Attributes are not included in this list. The default is that all elements and
subelements are selected. When you clear the box next to an element, all its
subelements are automatically cleared. Similarly, when you select the box next
to a child element, its parent elements are automatically selected. Selecting
only the elements and subelements you need for your map reduces the size of
the map and makes it more efficient.

11. If you are translating to XML, on the Output screen (from the Create a new
data format using this syntax list), select XML and click Customize.

12. In the New XML Wizard, select the Customization File Type—the type of file
you want to use to create your XML layout, either DTD or XML schema.

13. Type the name of the DTD or XML schema, type the URL, or browse to the
location of the DTD or XML schema, and click Next.

Note: When using the file:// protocol to reference a DTD, if you are unsure
or FTP connection (host name and FTP or Internet access) and the DTD is on
the Sterling B2B Integrator server, provide an absolute path in the reference by
omitting the host name and leaving the following slash. For example,
file://home/sterling/dtd/test.dtd. If you are sure or FTP connection, then
you can specify a host name.
If you are using an XML schema and the XML parser detects any errors, the
messages are displayed in an error window.

14. Select the root element. The DTD or schema does not explicitly define the root
element, so you can select from all the elements defined in the DTD or all the
top-level elements defined in the .XSD schema (elements subordinate to the
schema element). By default, the wizard selects the first element it encounters.

15. Specify the maximum length for data elements. For a DTD, you can specify
the maximum length of data elements because length is not defined in the
DTD and is optional for elements declared in the XML schema. For an XML
schema, the maximum length can be specified for some elements. You can
specify a default field length for elements that do not have a specified field
length.
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16. If you want the map to contain code lists equivalent to the enumerations
defined in the DTD or schema, select the Build code lists for enumerated
attributes check box.

Note: The default for the Build code lists for enumerated attributes check box
is cleared because using code lists may be redundant and thus your map is
smaller and more efficient without them.

17. Click Next.
18. If you chose to import an XML schema, select the subelements you want to be

included in the map, and click Next.

Note: The list displays the entire tree of elements and subelements for the
root element you selected, hierarchically displayed using indentation.
Attributes are not included in this list. The default is that all elements and
subelements are selected. When you clear the box next to an element, all its
subelements are automatically cleared. Similarly, when you select the box next
to a child element, its parent elements are automatically selected. Selecting
only the elements and subelements you need for your map reduces the size of
the map and makes it more efficient.

19. Click Finish.
20. The XML Load Warnings dialog box opens if there are any errors. If the

Sterling B2B Integrator Map Editor made changes to the DTD to make it
compliant with Sterling B2B Integrator, it indicates the changes. Click OK.

21. Continue with the New Map Wizard as directed. When you click Finish, the
Sterling B2B Integrator Map Editor displays the new map in the Sterling B2B
Integrator Map Editor window.

Overview: Creating XML Map Objects
The map objects that you can create depend on which map object is currently
selected (has focus in the map). The following table describes the available options
(N/A indicates that no map object can be created when the specified object is
selected):

If the Currently-Selected Object Is
Then You Can Create

XML File (root element)

v Element
v Content particle
v Pcdata
v Attribute

Element

v Element
v Content particle
v Pcdata
v Attribute

Content Particle

v Element
v Content particle
v Pcdata
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Pcdata N/A

Attribute Container
Attribute

Attribute
N/A

Managing the XML File
The XML File object represents the XML document that you are mapping, including
the root element. This object is created automatically by Sterling B2B Integrator
Map Editor. This table describes the two dialog boxes unique to the XML File
object:

Dialog Box
Function

XML File Properties dialog box
Enables you to define entities, output format specifications, and file-level
extended rules.

Entity Properties dialog box
Enables you to define entities. This dialog box is accessible through the
XML File Properties dialog box.

Note: The XML File object cannot be referenced by standard rules or links.

For more information, see:
v “Modifying XML File Properties”
v “Creating an Entity” on page 61
v “Regarding Decimal Points” on page 61

Modifying XML File Properties
About this task

To modify the properties of an XML file:

Procedure
1. Right-click the XML File icon and select Properties from the shortcut menu.

The Sterling B2B Integrator Map Editor displays the XML File Properties dialog
box (Name tab displayed by default).

2. Do you want to create an entity?
v If Yes, click the Entities tab to access entity options.
v If No, continue with step 3.

3. Do you want to modify the output options for the XML file?
v If Yes, click the Output tab and continue with step 4.
v If No, continue with step 5.

4. In the Output tab, specify the following:
v Whether the translator generates a prolog or document type declaration
v Public ID (if applicable)
v System ID (if applicable)
v How the XML elements are output to the file
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v Do you want to specify an extended rule for the XML file?
v If Yes, select the Loop Extended Rules tab, define the rule, and continue

with step 6.
v If No, continue with step 6.

5. Click OK. The Sterling B2B Integrator Map Editor saves your changes and
closes the XML File Properties dialog box.

Creating an Entity
About this task

An entity is an object that represents a string of characters. To create an entity:

Procedure
1. In the Sterling B2B Integrator Map Editor, right-click the XML root element.

From the shortcut menu, select Properties.
2. In the XML File Properties dialog box, click the Entities tab to access the entity

options.
3. Click New.
4. In the Entity Properties dialog box, specify the properties as necessary.

Note: In the Tag tab, the tag must match the entity tag in the XML document.
XML tags cannot contain spaces.

5. Click OK to save the entity and close the Entity Properties dialog box.
6. Click OK again to close the XML File Properties dialog box.

Regarding Decimal Points
About this task

If you need to specify that each decimal point in your data is defined and
generated as a something other than the default period (.), you can do so on the
Decimal Point tab.

To change the default decimal point setting:

Procedure
1. In the Sterling B2B Integrator Map Editor, open each XML file.
2. Open the XML File Properties dialog box.
3. In the Settings tab, select the Define Decimal Point check box.
4. In the Define Decimal Point check box, select whether you want to define a

character to use as a decimal point. Then, in the Decimal Point Character box,
type the character that the translator will identify as a decimal point. This
resets the decimal point default to use what you specified instead of a period.

5. Click OK.
6. Save the map.
7. Compile the map. The decimal point setting is now correctly set to use your

specification.
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Managing XML Elements
An XML element contains related elements, content particles, or both. In addition,
an element can contain one pcdata, one attribute or both. These objects repeat in
sequence until either the element data ends or the maximum number of times that
the loop is permitted to repeat is exhausted.

Note: The XML Element object cannot be referenced by standard rules or links.

For more information, see:
v “Creating an Element”
v “Inserting an Element from a Schema or DTD” on page 63

Creating an Element
About this task

To create an element:

Procedure
1. Right-click a map object and select either Create Sub or Insert from the

shortcut menu.
2. From the shortcut menu, select Element. The Sterling B2B Integrator Map

Editor displays the XML Element Properties dialog box.
3. In the Name tab, specify the following:
v Unique element name
v Description (if applicable)
v Additional notes

4. If necessary, click the Tag tab and change the value in the Tag box.

Note: This value must match the element in the XML document. XML tags
cannot contain spaces.

5. Select the Repeating tab to access the occurrence options.
6. Select either the Conditional or Mandatory option to specify whether the

element is required in the map.
7. Select the appropriate repeating option for the element.
8. If you must specify the number of times the element can repeat (loop), type

that number in the Maximum usage box.
9. Did you specify that the element repeats (loops)?
v If Yes, continue with step 11.
v If No, continue with step 12.

10. Do you want to specify an extended rule for this element?
v If Yes, click the Loop Extended Rules tab, define the rule, and continue

with step 12.
v If No, continue with step 12.

11. Click OK. The Sterling B2B Integrator Map Editor saves the element and
closes the XML Element Properties dialog box.
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Inserting an Element from a Schema or DTD
About this task

The Insert Element from Schema or DTD function enables you to add an element
from a schema or DTD.

To insert an element from a schema or DTD:

Procedure
1. Right-click the XML map component after which you want to insert the

element and select Insert > Element from schema/dtd, or if you want the
element to be the first element in the XML file format, right-click the XML File
icon and select Create Sub > Element from schema/dtd.

2. From the Customization File Type list, select whether the element will be
copied from a DTD or schema.

3. In the File Location box, type the file path and name of the DTD or schema
or click Browse and select the file (then click Open).

4. Click Next.
5. Follow the instructions on the next wizard page and click Next.
6. If you chose to insert the element from a schema, you are prompted with

another wizard page. Follow the instructions on that wizard page and click
Next.

7. Click Finish to insert the element into your XML file format. The Sterling B2B
Integrator Map Editor displays the XML Element Properties dialog box so you
can configure the element properties. If the inserted element is an abstract
one, the displayed XML Element Properties dialog box enables you to provide
a concrete element to replace the abstract one, by clearing the Defined as
Abstract check box on the Tag tab (you must replace abstract elements with
concrete elements by clearing this check box to avoid map compilation errors
or, optionally, you can avoid the compilation errors by deactivating the
abstract elements). For more information about abstract elements, see
“Abstract Elements and Sterling B2B Integrator Map Editor” on page 55.

8. In the Name tab, specify the description (if applicable).

Note: The Additional notes box is populated automatically with the XML
element annotation when you import an XML schema.

9. If necessary, click the Tag tab and change the value in the Tag box.

Note: This value must match the element in the XML document. XML tags
cannot contain spaces.

10. If the element is an abstract type, select the Tag tab and clear the Defined as
abstract check box. By clearing this check box, you change the abstract
element to a concrete one. This check box must be cleared to enable the map
to compile successfully (without compilation errors).

Note: Optionally, you can avoid compilation errors from abstract elements by
deactivating the abstract elements.

11. Select the Repeating tab to access the occurrence options.
12. Select either the Conditional or Mandatory option to specify whether the

element is required in the map.
13. Select the appropriate repeating option for the element.
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14. If you must specify the number of times the element can repeat (loop), type
that number in the Maximum usage box.

15. Did you specify that the element repeats (loops)?
v If Yes, continue with step 11.
v If No, continue with step 12.

16. Do you want to specify an extended rule for this element?
v If Yes, click the Loop Extended Rules tab, define the rule, and continue

with step 12.
v If No, continue with step 12.

17. Click OK. The Sterling B2B Integrator Map Editor saves the element and
closes the XML Element Properties dialog box.

Managing Content Particles
In Sterling B2B Integrator Map Editor, a content particle contains child objects that
define either a choice or a sequence. A content particle can contain related
elements, content particles, or both. In addition, a content particle can contain one
pcdata. If specified, these objects repeat in sequence until either the content particle
data ends, or the maximum number of times that the loop is permitted to repeat is
exhausted.

Note: The Content Particle object cannot be referenced by standard rules or links.

Creating a Content Particle
About this task

To create a content particle:

Procedure
1. Right-click a map object and select either Create Sub or Insert from the

shortcut menu.
2. From the shortcut menu, select Content Particle. The Sterling B2B Integrator

Map Editor displays the Content Particle Properties dialog box.
3. In the Name tab, specify the following:
v Unique content particle name
v Description (if applicable)
v Additional notes

Note: The Additional notes box is populated automatically with the XML
content particle annotation when you import an XML schema.

4. Click the Type tab to access the content particle type options.
5. Select the appropriate option to define what the child objects of the content

particle represent.
6. Click the Repeating tab to access the occurrence options.
7. Select Conditional or Mandatory to specify whether the content particle is

required in the map.
8. Select the appropriate repeating option for the content particle.
9. In the Maximum usage box, type the number of times the content particle can

repeat (loop).
10. Did you specify that the content particle repeats (loops)?
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v If Yes, continue with step 11.
v If No, continue with step 12.

11. Do you want to specify an extended rule for this content particle?
v If Yes, select the Loop Extended Rules tab, define the rule, and continue

with step 12.
v If No, continue with step 12.

12. Click OK. The Sterling B2B Integrator Map Editor saves the content particle
and closes the Content Particle Properties dialog box.

Managing Pcdata
A pcdata object contains character data in an XML document. Only one pcdata
object can be defined per element or content particle. Sterling B2B Integrator Map
Editor automatically names the pcdata object with the name of the parent element
or content particle.

Note: When a pcdata has an operation performed against it (link, standard rule, or
as an extended rule storage field), the displays a red check mark over the pcdata
icon.

Note: By default, the translator always trims “white space” from XML Pcdata
fields during input. To control this behavior (to deactivate the trimming of Pcdata
white space by the translator during input), add the line trimPcdata=false to the
customer_overrides.properties file in the Properties directory.

White space can be trimmed from pcdata objects on both the input and output
sides of the map. The default property value for the trim pcdata setting is Use trim
setting from customer_overrides.properties for the input side of the map and
Never trim whitespace from PCDATA on the output side of the map.

Creating a Pcdata
About this task

To create a pcdata:

Procedure
1. Right-click a map object and select either Create Sub or Insert from the

shortcut menu.
2. From the shortcut menu, select Pcdata. The Sterling B2B Integrator Map Editor

displays the Pcdata Properties dialog box.
3. In the Validation tab, specify the following:
v Whether the pcdata is required
v Minimum length
v Maximum length
v Type of data
v How the data is formatted

4. Do you want to specify an extended rule for this pcdata?
v If Yes, click the Extended Rule tab, define the rule, and continue with step 5.
v If No, continue with step 6.

5. Do you want to specify a standard rule for this pcdata?
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v If Yes, click the Standard Rule tab, define the rule, and continue with step 6.
v If No, continue with step 6.

6. Click OK. The Sterling B2B Integrator Map Editor saves the pcdata and closes
the Pcdata Properties dialog box.

Managing Attributes
In Sterling B2B Integrator Map Editor, each attribute is contained in an attribute
container. An element can only have one attribute container object, but the
attribute container object can enclose many attribute objects.

Note: When an attribute has an operation performed against it (link, standard rule,
or as an extended rule storage field), the Sterling B2B Integrator Map Editor
displays a red check mark over the attribute icon.

The attribute container object does not correspond to an XML feature. Sterling B2B
Integrator Map Editor uses attribute container objects to contain the attributes of
an XML element, so attribute containers do not have properties. An attribute
container object is automatically created when you create the first attribute of an
XML element. Subsequent attribute objects are created in the existing attribute
container object.

The attribute object specifies information associated with an element that further
defines the element.

Creating an Attribute
About this task

To create an attribute:

Procedure
1. Right-click a map object and select either Create Sub or Insert from the

shortcut menu.
2. From the shortcut menu, select Attribute. The Sterling B2B Integrator Map

Editor displays the Attribute Properties dialog box.
3. In the Name tab, specify the following:
v Unique attribute name
v Description (if applicable)
v Additional notes

Note: The Additional notes box is populated automatically with the XML
attribute annotation when you import an XML schema.

4. If necessary, click the Tag tab and change the value in the Tag box.

Note: The value in the Tag box must match the attribute tag in the XML
document. XML tags cannot contain spaces.

5. Click the Type tab to access the attribute type options.
6. In the Type tab, specify the following:
v Attribute type
v Default usage of the attribute
v Default value (only if you selected Default Exists or Fixed)
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Note: To use an enumerated attribute, you must also create a code list and
use a code list standard rule with the attribute.

7. Click the Validation tab to access the validation options.
8. In the Validation tab, specify the following:
v Minimum length
v Maximum length
v Type of data
v How the data is formatted

9. Do you want to specify an extended rule for this attribute?
v If Yes, click the Extended Rule tab, define the rule, and continue with step

10.
v If No, continue with step 11.

10. Do you want to specify a standard rule for this attribute?
v If Yes, click the Standard Rule tab, define the rule, and continue with step

11.
v If No, continue with step 11.

11. Click OK. The Sterling B2B Integrator Map Editor saves the attribute and
closes the Attribute Properties dialog box.
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Chapter 5. SPEC2000 Properties

The following properties (in the customer_overrides.properties property file) are
used for SPEC2000:
v The spec2000.teis.crlfReqAtBlockStartAndEnd property determines for which

TEIS the following rule is applicable. The rule is that each occurrence of the TEI
in an online message is transmitted as a separate line starting with the TEI and
ending with /(CRLF), or, if the last line, (CRLF) only. The TEIS currently
supported by this property are: REM, CST, DDT, AMU, SAR, RET, INT, ADT,
AMT, CRT, and DRT.

v The spec2000.processPNR.input property allows you to refactor or validate PNR
data on the input side of the map. The three valid values are:
– refactor refactors the data before storing it in the storage
– validate validates against the given rules and throw appropriate error
– none skips any refactoring or validation and allows Sterling B2B Integrator

Map Editor to handle the PNR data
v The spec2000.processPNR.output property allows you to refactor or validate

PNR data on the output side of the map. The three valid values are:
– refactor refactors the data before storing it in the storage
– validate validates against the given rules and throw appropriate error
– none skips any refactoring or validation and allows Sterling B2B Integrator

Map Editor to handle the PNR data
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Chapter 6. SPEC2000 Translation Detail Report

About this task

The EDI Translation Detail report enables you to access EDI data (for a particular
standard like SPEC2000) for a specified time period. It further allows you to
organize the report by selecting criteria such as direction of the transmission,
sender and receiver identifier, envelope name, unique identifier for the envelope
level, EDI standard used, and translation success or failure, among other
parameters. This report allows you to quickly and easily access information about
EDI translation through the system.

To run a report containing details on inbound/outbound SPEC2000 messages:

Procedure
1. From the Operations menu, select Reports.
2. Use the Report Configuration wizard to create a new EDI Transaction Detail

report.
3. On the Detail Filtering page in the Standard parameter, clear the checkboxes

for all standards except SPEC2000.
4. Filter by any other desired criteria and click Finish at the end of the Report

Configuration Wizard to save the report configuration.
5. Use the Report Source Manager to execute and view the report from your

saved configuration.
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Chapter 7. SPEC2000 Outbound Acknowledgement Report

About this task

The EDI Outbound Acknowledgement report enables you to monitor functional
acknowledgements at the group or interchange level, organized by parameters
including sender identifier, receiver identifier, EDI standard, and acknowledgement
status. You may want to use this report to determine, for example, how many
functional acknowledgements from a specified sender identifier are overdue.

To run a report containing details on SPEC2000 acknowledgements:

Procedure
1. From the Operations menu, select Reports.
2. Use the Report Configuration wizard to create a new EDI Outbound

Acknowledgement report.
3. On the Detail Filtering page in the Standard parameter, clear the checkboxes

for all standards except SPEC2000.
4. Filter by any other desired criteria and click Finish at the end of the Report

Configuration Wizard to save the report configuration.
5. Use the Report Source Manager to execute and view the report from your

saved configuration.
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Chapter 8. Searching for SPEC2000 Correlations

About this task

Correlation data, often called correlations, is defined as specific pieces of data that
you may need to review in the process of monitoring, tracking, and
troubleshooting your activities. These data items are defined by type and value.
These type-value pairs are known as name-value pairs, and are a powerful tool
you can use to record and search for business process- and document-specific data.
Sterling B2B Integrator has some predefined correlations and enables you to define
more so that you can easily and efficiently monitor and track your activities, such
as SPEC2000 message flow.

To search for SPEC2000 interchange correlations:

Procedure
1. From the Administration menu, select Business Process > Monitor >

Advanced Search > EDI Correlation.
2. In the Search Option area, specify any combination of the following search

criteria, as appropriate. To search for SPEC2000 messages, in the Interchange
Level Options Standard box, type SPEC2000.

3. Click Go! to display the EDI correlation records that match your search criteria.

4. In the EDI Correlation Interchange Results page, click info in the Detail
column for the SPEC2000 interchange for which you want to view details.

5. In the EDI Correlation Interchange Detail Results page, click info to the
right of Document Correlations for additional information about the SPEC2000
messages.

Searching for SPEC2000 Transaction-Level Correlations
About this task

To search for SPEC2000 transaction-level correlations:

Procedure
1. From the Administration menu, select Business Process > Monitor >

Advanced Search > EDI Correlation.
2. In the Search Option area, specify any combination of the following search

criteria, as appropriate. To search for SPEC2000 messages, in the Transaction
Level Options Standard box, type SPEC2000.

3. Click Go! to display the EDI correlation records that match your search criteria.

4. In the EDI Correlation Transaction Results page, click info in the Detail
column for the SPEC2000 transaction for which you want to view details.

5. In the EDI Correlation Transaction Detail Results page, click info to the
right of Document Correlations for additional information about the SPEC2000
messages.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM® may not offer the products, services, or features discussed in this document
in other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi

Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise™, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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